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Safety Information

Before you use your Trimble product, make sure that you have read and understood all safety
requirements.

WARNING - This alert warns of a potential hazard which, if not avoided, could result in severe injury or even
death.

CAUTION - This alert warns of a potential hazard or unsafe practice that could result in minor injury or property
damage or irretrievable data loss.

Note — An absence of specific alerts does not mean that there are no safety risks involved.

Use and care

This product is designed to withstand the rough treatment and tough environment that typically
occurs in construction applications. However, the receiver is a high-precision electronic instrument
and should be treated with reasonable care.

,/i\ CAUTION - Operating or storing the receiver outside the specified temperature range can damage it.

Vehicle safety

& Warning — When you select the Vehicle mode, the following warning message appears:

WARNING: Do not operate SCS900 while driving the vehicle. Failure to heed this warning may result in a
collision causing property damage or personal injury.

Do not interact with the touch screen, keyboard, or software in any way while the vehicle is moving. While the
vehicle is moving, the software provides a continuous display of position and data that can be seen at a glance.
Operating the device or interacting with the software while the vehicle is moving can be a distraction for the
operator, and may result in collision causing property damage or personal injury.

Servicing

Do not attempt to repair a Trimble Site Tablet or Trimble TSC3 controller. There are no user-
serviceable parts inside. To arrange for a controller to be serviced, please contact your Trimble
dealer.
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Safety Information

& Caution — When you select the Vehicle mode, the following warning message appears:

WARNING: Do not operate SCS900 while driving the vehicle. Failure to heed this warning may result in a
collision causing property damage or personal injury.

Do not interact with the touch screen, keyboard, or software in any way while the vehicle is moving. While the
vehicle is moving, the software provides a continuous display of position and data that can be seen at a glance.
Operating the device or interacting with the software while the vehicle is moving can be a distraction for the
operator, and may result in collision causing property damage or personal injury.

Accessories

& Caution — Use only approved accessories with this equipment. In general, all cables must be high quality,
shielded, correctly terminated, and normally restricted to two meters (6.56 feet) in length. AC adapters approved
for this product have special provisions to avoid radio interference and must not be changed or substituted.
Unapproved modifications or operations beyond, or in conflict, with these instructions for use may void
authorization by the authorities to operate the equipment

Trimble SCS900 Site Controller Software User Guide 4



Contents

Safety Information .l 3
US AN Cal® Lo 3
VENiCle SafE Y . 3
S OIVICIN G 3
LSS O IS e 4

L INtrodUCH ON 8
Related INTOIMI AT ON .. 9
Technical SUP PO« .. 9

2 Starting the Software . . 10
SYSteM INfOrmMatiON 11

B VIS 13
ThE HOM @ M ONU e e L 14
The St M ONU 15
TE GP S M ONU e 16
The Total Station MeNU 17
The IM POt/ EXP Ot MBNU e e 18
The MeasUIre M eNU 19
The STaKe M BNU e 20
The COGO MEBNU oo e L 21
T Xt M ONU L 21

4 MeEasSUIrEMEBNT SCECON . .. 22
M EaSUIe MO OS 23

GP S MEASUIe MO e 23
Total Station MeasUre MO ... 23
S AU DA 24
GP S MO .. 24
Total Station MO . 25
Precision GNSS CONtIrOl ICONS e 25
GP S MO .. 25
AP ORI ONS 26
M CONTIOl . 26
M ASUIE LA o 27
DS N LA . 28
LAY IS taD L 29
RO 1A 29



INT0 DarS L 31
Antenna Height / Target Height .o el 32
Trim bl ICON M N . 33
MBS U M BNU . 33
SHaK Ot M ENU 34
Data Management L 36
Sites, Designs, and Work Orders il 37
Creating and opening a work orderin the fleld ... e 38
Connected ComMMUNIY SEIVICE . 40
Registering the CONtroller . . 40
Wireless Data SYNC .. 41
Remote ASSiStaNt . 42
Measurement Work I OWS 44
Displaying CUt/Mill _ 44
Checking a grade/elevation .. . 45
Checking material thiCKnN eSS . ... 46
Measuring a surface or a featUre .. L 46
Measuring with feature codes — Advanced Measurement module required ... ... ... 48
POt OS il 49
Volume and COGO ..o L 50
ComMPULE VOIUM S 51
ReVieW & Edit Data ... 53
CrEate POINTS ATCS .. e 54
Enter/Edit StakeoUt POINtS . 56
StakeoUt WorK oW . L 57
P OINES 58
Stakeo U SettiNGS . il 59
Measured POt L 60
GroUNG SUIMaCE 60
ToP OF STaKE 60
LN S . 61
SI0P STAKINE L 62
REfErENCE LiNe 64
UGS . 65
ROATS il 65
Roadway feature StakKing ... 66
Simple feature Off st ... 68
CUStOmM fRatUIre STAKING . . 69
Custom segment StaKing il 69

CatCh POINt STAKING e 70



Location ON SUITaCe . 71

O Measuring WIth GPS . 73
Setting up the GPS base station .. il 74
Setting Up the GPS rOVEr FECEIVET .. . 75
Calibrating the Site .o 75
Performing a two-point calibration ... . . 77
Troubleshooting a site calibration ... 77
Measuring @ NeW CONtrOl POINt 78

10 Measuring with a Total Station .. 79
Connecting to atotal STatioN .. . L 80
Leveling the total station .. il 80
Establishing the station L. L 81

AT Itrary l0CatiON 82
Setting Up 0N @ KNOWN POINt 83
Reading station setup data from the total station ... .. . 84
Completing a station establishment where the height of the setup point has not been determined ..................... 84
Working with a mechanical total station . L 84
Measuring with a mechanical total station ... .. . 84
Staking with a mechanical total station ... .. 84

11 Machine Control 86
Setting up for machine coNtrol .. L 87
Defining the window for Full Search mode ... . 87

12 Advanced Total Station Features ... .l 91
SCaANNING STOCKPIIES . . L 92
Adjusting the total StatioN . . 95

12 GlOSSANY ..o 929



Introduction

In this chapter:

m Related information

» Technical support

CHAPTER

This manual provides you with the necessary
information to perform measurement tasks with
the Trimble® SCS900 site controller software. To
perform these measurement tasks, you need the
SCS900 site controller software running on a
controller that is either connected to a Precision or
Location GNSS system, or to a total station. You
can also use the internal GPS of the device to
locate objects. The SCS900 software is the field
software that runs on a Trimble Site Tablet and the
Trimble TSC3 controller. For presentation and
training purposes, a software emulator that runs
on a Windows operating system is also available.

The SCS900 software is a site measurement tool
that streamlines earthworks and surface finishing
operations. It enables construction contractors to
measure material volumes, monitor grades and
laid material thicknesses, and to perform site
measurement tasks such as point, line, and
surface stakeout.

Start up and set up of the sophisticated GPS and
total station technology is quick and easy. The
software manages data for multiple project sites,
single large project sites, and large sites that have
been divided into zones. When a field engineer
opens a work order, the software opens all data
files needed to complete that work order. Because
the software delivers results immediately,
informed decisions can be made in the field.

The software can also be used to check site
grading operations that have been performed
using a machine control system, such as a Trimble
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1 Introduction

GCS900 Grade Control System. If your organization does not have a 3D machine control system, the
system provides site control, grade control, progress volumes, and stakeout capabilities to facilitate

earthmoving operations.

The field engineer can quantify progress, check data, and set out the information needed to keep
the machines moving. The SCS900 system tracks activities at each site and keeps a continuous

record of all results. Related data is stored, together, as a permanent construction record and is also

output as a TXT or DXF file. Back at the office, the software delivers comprehensive operation
analysis data.

Even if you have used other GNSS or GPS products before, Trimble recommends that you spend
some time reading this manual to learn about the special features of this product. If you are not
familiar with GNSS or GPS, visit the Trimble website (www.trimble.com).

Related information

Sources of related information include the following:

o Release notes — The release notes describe new features of the product, information not
included in the manuals, and any changes to the manuals. They can be downloaded from the
Trimble website at www.trimble.com/construction/heavy-civil/site-positioning-
systems/scs900.aspx?dtID=support.

e Trimble training courses — Consider a training course to help you use your GNSS system to its
fullest potential. For more information, go to the Trimble website at
www.trimble.com/training.html.

Technical support

If you have a problem and cannot find the information you need in the product documentation,
contact your local dealer. Alternatively, go to the Support area of the Trimble website
(www.trimble.com/support.shtml). Select the product you need information on. Product updates,
documentation, and any support issues are available for download.

If you need to contact Trimble technical support, complete the online inquiry form at
www.trimble.com/support_form.asp.

Trimble SCS900 Site Controller Software User Guide
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CHAPTER

Starting the Software

In this chapter:

= System information

To start the SCS900 software on your controller,
tap Start and then select Trimble SCS900. The
SCS900 software will start in the Open Site dialog
where you can select an existing site, design, and
work order on your controller or create a new one.

Open Site
Site: \Westmoor Road
Work Order: |stake Me

EIENEN

Design: ((No design needed)

Cancel

After accepting the selection, the software will load
your data and load the map view. If you have
previously connected a rover receiver to the site
base station, the software tries to automatically
connect with the last used configuration.

Trimble SCS900 Site Controller Software User Guide 7



2 Starting the Software

4 | LULTCETPY | E: 946903.400 | N:2312571.367

Thickness: ---

« | R |

Dsn Elv: --- |

[ ey
RS 600 usft

and tap GPS or Total Station to start the setup.

System information

808 plHR |y

..ﬂ _. B ff nFR@0Y g e ' Measure

If the software is not automatically connecting to your positioning device, go to the Home menu

The System Information dialog has multiple tabs that contain information about the current version

of the SCS900 software, which modules are enabled, which positioning sensors are connected and

which firmware the sensors have. From the Trimble icon menu, select System Info.

If you have purchased a module after the controller was activated, activate the new module by
tapping Update License in the Modules tab.

System Information

\About \| Version \| Modules | Regional N\
Module |Status \

Roading Stakeout and Measurement Enabled

Advanced Measurement Enabled
Options:

EmulatorShowActualSize Enabled
FakePosition Enabled

Update License

Cancel

Trimble SCS900 Site Controller Software User Guide

8



2 Starting the Software

In the Regional tab, you can toggle between different supported languages:

System Information

\.About N\ Version

\| Modules \| Regional

Application language:

[English (US)

Dansk

Deutsch

English (British)
English (US)
Espafiol
Francais
Italiano

Nederlands

Trimble SCS900 Site Controller Software User Guide
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CHAPTER

Menus

In this chapter: The software is a menu-driven system. From the

= The Home menu Map screen you can access the main menu

through the Home button at the bottom left of

the screen. The Trimble icon menu next to it

s The GPS menu contains related functions to the mode currently
in use.

s The Site menu

= The Total Station menu
= Thelmport/Export menu
= The Measure menu

m The Stake menu

= The COGO menu

s The Exit menu

Trimble SCS900 Site Controller Software User Guide 10



3 Menus

The Home menu

The Home menu is the main menu of the SCS900 software. It contains the following buttons:

Home: Vulcan Road X

e

Total Station Import / Export

i@

Measure Exit SCS900

To access it, tap n

Trimble SCS900 Site Controller Software User Guide 11



3 Menus

The Site menu

The Site menu contains the tools to create, open, and complete sites, designs, and work orders. You
can also change the design referenced by the current work order, and create new designs.

From the Home menu, tap Site.

You can create a new site, design, and work order. At the top of each list, the software displays the
last three items that have been used and then all remaining data on the controller:

Open Site
Site: Westmoor j

Work (Ordare [haa L L 1] I

J New Site... »—
Westmoor

Desig

Westmoor Road
Miramonte

12-002 E Washington Ave
13992- 905 Freeway

999

Alex

Trimble SCS900 Site Controller Software User Guide 12



3 Menus

The GPS menu

#

GRS

The GPS menu contains the control and system setup functions for GNSS operation. Use this menu
to start the rover receiver, carry out a site calibration, or select a predefined coordinate system. You
can also enter and edit control point information, measure new control points for the project, and
recheck the system setup on a control point.

From the Home menu, tap GPS.

The following commands are available from this menu:

Command Description
"f- = Set up and start a GNSS base station, rover receiver, configure
static measurements, or start the internal GPS of the controller.
Connect

Site

N

Coordinate

Recheck
System

W

Enter [ Edit
Control Points

o

Measure

=S
Calibration

System

o

Control Point

Perform or resume a single-point, two-point, or multi-point site
calibration.

Select a predefined coordinate system from the coordinate

system library.

Check an existing site calibration on a known control point.

Edit and enter control point coordinates.

Measure new control points.

Trimble SCS900 Site Controller Software User Guide 13



3 Menus

The Total Station menu

I

Total Station

The Total Station menu contains the control and system setup functions for total station operation.
Use this menu to connect the instrument and carry out total station setup to establish the position
and orientation of the instrument. The menu provides access to all total station control functions.
General functions include being able to enter and edit control point information, measure new
control points for the project, and recheck the system setup on a control point.

From the Home menu, tap Total Station.

The following commands are available from this menu:

Command Description
- Connect to the total station using either a cable, Bluetooth® wireless

technology, or a radio for robotic operation.

Connect

Set up the total station and establish its position and orientation on the
site using the known point or arbitrary location (also known as free
station or resection) methods.

Check an existing site calibration on a known control point.

Edit and enter control point coordinates.

Enter / Edit
Contral Points

f. Measure new control points.
a'A

Measure
Control Point

Trimble SCS900 Site Controller Software User Guide 14



3 Menus

The Import/Export menu

Use this menu to export measured information or selected design information to an external
memory device such as a USB flash drive. It also includes export functions for data use in the GCS900
Grade Control System or the Accugrade machine control systems.

From the Home menu, tap Import/Export.

The following commands are available from this menu:

Command Description
i Write the surface data that was measured in the field to a new design surface.
o=
Surface as
Design

Export measured data in a CSV File or in a DXF File, write the measured data in

<3 a Record.txt file, or export data as a custom report using a stylesheet
T - template.
Data
i Export a design to a CompactFlash card or USB drive for use with the GCS900
i Grade Control System.
Export to
GCS900
% Synchronize data with the Connected Community service using the Wireless
/@ Data Sync function.
Connected
Community
iy Enter the device credentials to access the Connected Community service.
%
Community
Settings

Trimble SCS900 Site Controller Software User Guide 15



3 Menus

The Measure menu

-

The software always initially starts in the Measurement mode. Use this option to switch between
stakeout and measure.

From the Home menu, tap Measure.

In this menu, you can accomplish all site measurement functions including:

e Grade checking

e Material thickness checking

e Topographic measurements to create surface models (for example, volume computations)
o Site feature measurements to record the location of non-surface features

e Real-time cut/fill information against a selected design model

Before you use this menu, set up your GPS or total station function in the Home menu. If you have
not yet done a system setup when you select an option in this menu, the software automatically
puts you through either the station establishment process for a total station, or the rover setup for
GNSS.

If points or lines are stored as part of a DTM surface or only as a site feature, they can be defined in
the Measure Type dialog to the left of the status bar. When the Advanced Measurement module is
installed, the measurement type is controlled by the settings in the Feature Code Library for each
feature code.

IMeasure Type
| Point V Existing Line W New Line
Point name: Topol9
Point code: |
Point type: |Surface B
Show every time: Yes v

Trimble SCS900 Site Controller Software User Guide 16



3 Menus

The Stake menu

:

The Stake menu contains all stakeout functions including staking points, lines and alignments,
surfaces, side slopes, catch points, and road features. Before you use this menu, set up the system
using the System Setup menu.

From the Home menu, tap Stake.

After selecting the stakeout function, the object selection screen appears. Select the object that you
want to stake out either directly from the map or from the list in the top right corner of the screen

After you select an object, multiple stake methods are available that differ depending on the type of
object that you selected. For more information, see Stakeout Workflow, page 57.

Object:
Stake method:

Trimble SCS900 Site Controller Software User Guide 17



3 Menus

The COGO menu

The Volume & COGO menu contains a number of calculations, for example, area, distance, bearing,
slope, and point generation functions that can be used to generate points for stakeout operation
from CAD data in the currently loaded design. The menu also provides access to review and edit
functions for editing breaklines and deleting points or lines to resolve surface modeling problems.

From the Home menu, tap COGO.

The following commands are available from this menu:

Command Description
View or delete point and lines, add breaklines and boundaries, and calculate
ﬂi surface volumes (stockpiles) or periodic progress volumes.
Review & Edit
Data
— Create points by a variety of methods including free point, radius, and offset
= S to aline. To create free points, tap the screen or enter its coordinates.
Create
Points, Arcs
- View all stakeout points of the currently selected design and edit their
coordinates.
Enter / Edit
Stakeout Points

The Exit menu

©

Exit SC5900

This menu closes the SCS900 software, and optionally can shut down the receiver.

From the Home menu, tap Exit SCS900.
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CHAPTER

Measurement screen

In this chapter: The software is a menu-driven system. From the

= Measure modes Map screen you can access the main menu

through the Home button at the bottom left of

the screen. The Trimble icon menu next to it

» Precision GNSS control icons contains related functions to the current mode in
use.

s Status bar

=  Map options

= The Total Station menu « | [TILTXXTZY | E: 946891718 | N:2312604.242 )
. . Dsn Elv: --- Thick HEES
= Toggling between Plan and Cross Section <« | GIER | psnewv | fekness >
view oo
- x x T
= Info bars GCK &
= Antenna Height / Target Height FH . . g
. . EOP A R \i\

= Trimble icon menu - a g
s1 x x Q
MH : o

b 1000 usft

h:-:-:-:‘

=Y fi gD m2a | Measure

»
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4 Measurement screen

Measure modes

The Measure mode controls a number of functions for the GPS receiver and total station. There are
multiple modes available, which you can switch between by tapping the Measure Mode icon on the
left side of the status bar or in the Trimble icon menu in the Measure Mode option.

GPS measure mode

GPS measure Name Description

mode

Standing Walk to a point and then take a single measurement.

Walking Walk the site and continuously take measurements. Points
| are stored based on a setting for horizontal distance and

elevation change, which can be set by tapping the Measure
mode icon either in the status bar or in the Trimble icon
menu.

Vehicle Drive the site in a vehicle. Points are stored based on a

C'*0 setting for horizontal distance and elevation change, which
can be set by tapping the Measure mode icon either in the
status bar or in the Trimble icon menu.

Static Measure a point for a longer period and to achieve a greater
accuracy.

Total Station measure mode

Total Station Name Description
measure mode

ﬁ Standing Walk to a point and then take a single measurement.
f Walking Walk the site and take continuously measurements. Points
| are stored based on a setting for horizontal distance and

elevation change, which can be set by tapping the Measure
mode icon either in the status bar or in the Trimble icon
menu.

m Vehicle Drive the site in a vehicle. Points are stored based on a
setting for horizontal distance and elevation change, which
can be set by tapping the Measure mode icon either in the
status bar or in the Trimble icon menu.

Trimble SCS900 Site Controller Software User Guide 20



4 Measurement screen

Total Station Name Description
measure mode

Averaging Measure a point in multiple faces/rounds.

Ij"DR DR Measure a point using a DR reflectorless total station.

Status bar

The status bar at the bottom of the screen contains relevant information about the current status
of the positioning system, battery status, measure mode, and measurement type. The icons change
slightly depending on the positioning device. The following icons are typically available:

GPS mode

Icon Description

Indicates the current measure mode in use. See Measure modes, page 23
The number of satellites being tracked and radio connection status to the
base station.

The horizontal and vertical precision of the GPS position solution.

The battery level of the controller and externally connected GNSS receiver.

Cell signal reception for the internal cell modem.

Measurement type (Point, Line, Surface Feature).

Random/Fixed Station Mode Staking.

Stake Method.

Trimble SCS900 Site Controller Software User Guide 21



4 Measurement screen

Total Station mode

Icon Description

Indicates the current measure mode in use. Please read the chapter about
measure mode for a more detailed description.

=¥

Target Tracking Status and access to the control panel.

-
—é

Shows the battery level of the controller and total station.

=
s

Cell signal reception for the internal cell modem.

Measurement type (Point, Line, Surface Feature).

Random/Fixed Station Mode Staking.

Stake Method.

EE0E

Precision GNSS control icons

When using the internal GPS or while connected to an external SPS receiver, an icon panel appears
at the bottom of the screen. The display swaps permanently between the following two panels:

11 4 @

GPS mode

This icon... Shows...

14

how many satellites are being tracked.

the radio connection status.

b:@i

Trimble SCS900 Site Controller Software User Guide 22



4 Measurement screen

This icon... Shows...

the battery level of the controller.

the battery level of the GNSS receiver.

the horizontal and vertical precision of the GPS position solution.

Tap one of these icons to show more detailed information. To access the sky plot of the current
satellite constellation, tap the Satellite icon:

GPS Status
N Sats Used: 11
T Position: Fixed
Precision:

Hz: 0.026 usft

Vt: 0.049 usft

Tolerances

[ ]GPS Only

The Tolerances button, which appears when the controller is connected to an SPS receiver, is a
shortcut to the RTK Precision option. The GPS Only check box enables you to toggle between using
GPS and GNSS.

Map options

e

Map options enables you to customize what you see on the map. You can choose the information
that you want to view for the task rather than cluttering the screen with too much information.

Map control

The icons on the right of the screen enable you to move around the screen and toggle information
on and off to improve readability when there is a lot of information shown on the screen.
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4 Measurement screen

Icon Description

Measure tab

Zoom to the extents of the file.

Zoom in.

Zoom out.

View the display options.

Center the map on the current location.

+
+(
X
@l Zoom to a user-defined box (use a stylus to draw a box on the screen).

Toggle between the Plan and Cross Section view when staking lines and roads.

Use the Measure tab to filter the different measured data that is being displayed:

Map Options

‘ Measure \I Design
[ ]Point names
[ ]Point elevations
Control points
Measured surface
Coverage grid

Grid size:

& Cut/Fill

~ Elevation

\I Layers \I Rotate
[ ]Point codes

[ ]Point cut/fil
Stakeout points
Measured feature

|32.808 usft
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4 Measurement screen

Select this option...

to display...

Point names
Point elevations
Control points

Measured surface

Coverage grid

Point codes
Point cut/fill
Stakeout points

Measured feature

Design tab

the point names of every point on the map view.
the point elevations of every point on the map view.
control points on the map view.

measurements that were recorded as a surface.

a coverage map that shows cut/fill in tolerance values as
red/blue/green or different shades of blue to represent elevation
changes depending on the setting of the radio button.

the point codes of every point on the map view.
the cut/fillinformation for every point on the map view.
stakeout points on the map view.

measurements that were recorded as a site feature.

Use the Design tab to filter the different design data types that are displayed:

Map Options

\ Measure \] Design

Design map

Guide arrow

[ ] Design contours
Contour interval:

Roaclway

|:| Display cross-section

\] Layers \] Rotate
Site map
Stakeout flags

3.000 usft
[ ] Cross section lines

Cancel

Select this option...

to display...

Design map
Guide arrow
Design contours

Roadway

the design map on the map view.
the guidance arrow to navigate to points of interest.
contours on the map view, if a design is loaded.

the center line of any roadway design.

Trimble SCS900 Site Controller Software User Guide
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4 Measurement screen

Select this option... to display...

Display cross-section display the slope values for each segment of a road cross section.
Site maps the site map on the map view.

Stakeout flags stakeout flags on the map view.

Cross section lines the cross sections of any loaded roadway design.

Layers tab

Ifthere is a lot of data displayed, use the Layers tab to turn layers on and off in the design map to
improve readability.

Map Options
\ Measure \] Design \] Layers \] Rotate

0 (3081) —
UTILITIES (138)

[w] TREES (3762)

[w] SURVEY (330)

ROAD_DESIGN (2)

ROAD (34)

POINTS (0) |
HOUSE (5)

DEFAULT _LAYER (9)
CONTROL (0

— . ..

Cancel

Rotate tab

Use the Rotate tab to control the map rotation of the Measurement screen:

Map Options
\ Measure \] Design \] Layers \] Rotate
& Static

© Travel direction
© Follow alignment

¢ Up station

“ Down station
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4 Measurement screen

Select this option...  to orientate...
Static the map view to North.
Travel direction the map view to your direction of travel/walking.

Follow alignment (This option is only available when an alignment is selected.)
Up station the screen up station.

Down station the screen down station.

Note — When any option other than Static is selected, a North arrow automatically appears on the
screen.

Toggling between Plan and Cross Section view

If road or alignment data is loaded in the current design, a button on the bottom right of the screen
enables you to toggle between Plan and Cross Section view. A highlighted button shows that the
Cross Section view is enabled.

i | LULTCETFY | E: 946830.335 | N:2312679.539 )

|4 | E:946830.335 | N:2312679.539 | 2:55.881 | L= )
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4 Measurement screen

Info bars

At the top of the screen there are two bars that show readings and values related to the current
operation:

e DB | - | Wi | 2 | b | Lon p

4 IS | DsnElv:--- | Thickness: --- S

Use the arrows on the right and on the left to scroll through the different values which are currently
enabled. You can also tap on the bar and "flick" through the different values. For each function, a
predefined set of values is shown. You can modify the settings in the Trimble icon menu with the
Configure Info Bars option.

Some fields (for example, Antenna & Target Height, Stakeout line offset, and Surface offset) are
"active" fields. By tapping on it, you can change the settings and shortcut in the Settings dialog of
this value.

The following values are available:

This value Shows the...

Ant Ht currently applied antenna height.

Tar. Ht currently applied target height.

E current Easting in the selected/applied coordinate system.

N current Northing in the selected/applied coordinate system.

Elv current Elevation in the selected/applied coordinate system.

Horizontal angle current horizontal angle the instrument is shooting.

Vertical angle current vertical angle the instrument is shooting.

Slope distance current slope distance the instrument is shooting.

Lat current latitude in WGS-84.

Long current longitude in WGS-84.

Ht current height in WGS-84.

Sta current station to a selected road or alignment.

Off current offset from a selected road or alignment.

Go distance and direction guidance to a selected point or object.

Cut/Fill cut/fill value to a selected point, line, road, or alignment.

Dsn Elv design elevation of a selected point, line, road, or alignment. An
arrow next to the value indicates if a surface offset has been
applied.

Thickness current thickness of a layer vertical on the last layer.
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4 Measurement screen

This value Shows the...

R. Sta current station to the selected reference alignment.

R. Off current offset to the selected reference alignment.

dE difference in East to a selected point or object.

dN difference in North to a selected point or object.

dElv difference in Elevation to a selected point or object.

Ahead/Back difference in station to a selected point along the selected
alignment.

Inward/Outward difference in offset to a selected point relative to the selected
alignment.

Feature 2 cut/fill Cut/Fill 1-2 when using a primary and underlying surface.

Feature 2 design elevation
Dsn Sta

Stakeout line offset H
Stakeout line offset V

Surface offset

design elevation of a selected point, line, road, or alignment.
station to a selected point per design.

Currently-applied horizontal line offset.

Currently-applied vertical line offset.

Currently-applied surface offset.

Antenna Height / Target Height

To change the antenna or target height, tap on the value in the info bar. This value is subtracted
from each GPS elevation or elevation measured with a total station. If the antenna/target height is
currently not displayed in the info bar, turn it on in the Trimble icon menu using the Configure Info

Bars option.

[¢
Standing Mode Settings

Antenna height:

6.562 usft

Cancel
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4 Measurement screen

Trimble icon menu

2
Tap the Trimble button to directly access functions related to the current operation. A menu
similar to the one shown below appears:

Measure

X

p

=5

i

Measure Mode Reference Line Log System Info
r s r
@ J-J" ;': = g‘i
— b ==
Settings Measure Type Grade Report

The content alters with the current function and available data.

Measure menu

Icon

Description

oy

Measure Mode

Log

System Info

7

Toggle between Standing, Walking, Vehicle, Static, and Averaging
Mode.

Select a reference line or alignment to get station and offset in addition
to the current function in use.

View the log file of the current work order.

System information about the software including any modules
installed.
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4 Measurement screen

Icon Description
Configure the info bar or adjust the stakeout settings like settings for
the stakewriter tool, the Line settings, or the Road settings.
Settings
R, Toggle between measuring points, lines, surface, and site features.
"L i
Measure Type
Oz Generate a statistic about the quality of a surface grade check.
=
Grade Report

Stakeout menu

Icon Description
v‘]“ Toggle between Standing, Walking, Vehicle, Static, and Averaging mode.
coy,
Measure Mode

Select a reference line or alignment to get station and offset in addition

% to the current function in use.

Reference Line
View the log file of the current work order.
Log
- System information about the software including any modules
o installed.
System Info
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4 Measurement screen

Icon Description
I Change the settings for the stake writer tool, for example, the
l@ dimensions of your stake and the stake marking method.

Stakeout
Settings
Configure the info bar or adjust the stakeout settings like settings for
the stakewriter tool, the Line settings, or the Road settings.
Settings
IS Stake a different object.
b
Change Stake
Chject
I Stake a point with a different design elevation.
Stakeout
Elevation
- Stake a different station.
w
Mew Station
Stake a feature with an offset.
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Data Management

In this chapter:

n Sites, Designs, and Work Orders

» Creating and opening a work order in the
field

» Connected Community service

CHAPTER

Trimble recommends that you use the latest
version of the Business Center — HCE software to
prepare the data that should be used with the
SCS900 software. The Business Center — HCE
software incorporates the capabilities of the SCS
Data Manager and Report Utility for multiple
jobsite/controller management and generating
work order reports. The correct file folder
structure is automatically created and quality
assurance tools are available to ensure that all
controllers are using the most recent data.
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5 Data Management

Sites, Designs, and Work Orders

All data for the software is stored in a top-level folder called Trimble SCS900 Data, and is organized in
a precise structure. The file folder structure that you create on the office computer exactly mirrors
the file folder structure on the controllers, which makes it easy to manage and archive data between

the computer and the controllers. Data is organized by site. Within each site, data is divided into
designs and work orders.

Trimble SC5200 Data

I— C1\Site A

\Designs
| 1 \Design1
——— 1 \Design 2
1 \Design 3
“3\Work Orders
- Work Order A
—— 1 Work Order B
— 1 \Work Order €
L—— 3 "Work Order D

I 9\Site B

\Designs

L ) \Design 1
——— 1 \Design 2
—1 \Design 3
C1\Work Orders

—— 1 \Work Order A
—— 1 \Work Order B
—— 1 \Work Order C
~——— 1 \Work Order D

Information on a controller is arranged in the following levels:

Level Description

Global Global information is used at all sites. It includes lists of feature codes, Code
lists, and Geoid files.

Site Site information relates to all activities at the specified site. It includes control
points, site calibration results, and background maps. Site information is
always available.

Design Inside each site, a main Designs folder holds individual design folders that
contain design data pertaining to the site. Design data relates to a particular
phase of construction. Data stored at this level includes foreground maps,
stakeout data, and a design surface model.

Work Order Inside each site, a main Work Orders folder holds individual work order folders.
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5 Data Management

Creating and opening a work order in the field

From the Home menu, tap Site. After starting the software, you can select a site and work order to
start with:

Open Site

Site:

\Westmoor Drive

Work Order: |Car Park Asbuilt

1|1

Instructions: Car Park Asbuilt at Westmoor

Drive

Design: ((No design needed)

[ e il

Cancel

For each of these options, you can either decide to open an existing site, design, and work order, or
create a new one. The New option opens a screen with a number of fields where you can define the
settings and add data files from a USB drive or from data already stored on the controller.

CAUTION — Before taking a measurement or associating a design with the site, ensure that the distance units are
correctly set. All files that relate to a single site must be stored and operated with the same units. Once a

measurement is taken, or a design is selected, you cannot change the units.

When creating a site on the controller, you can import or measure a site calibration or use a
published coordinate system from the coordinate system manager. After you select the Select
coordinate system option and tap Select coordinate system, the software will list all supported
coordinate systems.

Site Creation Options

[ ] select site map:

|:| Select calibration file:

[ ] select FXL file: SCS900 Default.fxl
Select Coordinate System:

|
|
|:| Select control point file: |
|

Select Coordinate System
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5 Data Management

If you need to use a geoid, you must export it from the Business Center - HCE software the first time,
and store it in the Trimble GeoData folder.

Select Coordinate System

Coordinate system:

|US State Plane 1983
Zone:

|Co|orado North 0501
Geoid:

|Go9US.ggf

Cancel

A work order can include instructions for the person in the field explaining what tasks to carry out.
Work order instructions entered in the office will appear in this screen when selecting the work
order. When creating a work order in the field, instructions can be entered in the instruction box

too:

New Work Order

Work Order:

Instructions (optional):

Work orders should have a meaningful name to make it easy to identify them when multiple work

orders are created for a particular project.
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5 Data Management

Connected Community service

The Connected Community service includes the following services:

e Wireless Data Synchronization to synchronize SCS900 data with the data stored in the

Connected Community website

o IBSS (Internet Base Station Service) web service to receive base station corrections from the

local base station through the Internet

e Remote Assistant to remotely connect to a field controller for Trimble Support purposes.

All these service are tied to the device ID that you need to purchase for the controller with a

monthly TCC subscription.

Registering the controller

To use the controller with the Connected Community services, you must register the controller in

the Connected Community Device Manager of the user organization.

1. Inthe SCS900 software, select Import / Export.

2. Tap Community Settings

3. Enter the credentials and then tap Accept.

Community Settings

Cancel

Device ID: [EM-00000026

Device name: |Danie|

Organization: |trimb|ehh

Password: |password

Workgroup: |ie| Hoentzsch Work Group

You only need to do this once. You can also enter a work group for Wireless Data Sync to group
multiple controllers of a company in a certain structure.
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5 Data Management

Wireless Data Sync

The Wireless Data Sync option enables your SCS900 data to be synchronized with your data stored
in the Connected Community website, which eliminates the requirement to move data to and from
the field, but uploads design updates and work order results to the Connected Community website.

To manage the synchronization process, the following set of rules controls the dataflow to, and
from, the Connected Community website.

File Type Currently on the Currentlyon  Action
Connected the controller
Community
Work Order \/ X Download to the controller
X v Upload to the Trimble
Connected Community
service
/ \/ Upload to the Trimble
Connected Community
service
Design Data v X Download to the controller

Upload to the Trimble
Connected Community
service

x
<

<
<

Download if file size is
different

Site Download to the controller

x <
< %

Upload to the Trimble
Connected Community
service

<

Download if file size is
different

Calibration File (*.DC & *.CAL) / Download to the controller

< x<

) 4 Upload to the Trimble
Connected Community
service

y/ / Do nothing
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5 Data Management

File Type

Currently on the

Currently on

Action

Connected the controller
Community
Control Point File (*.csv) / X Download to the controller
X v Upload to the Trimble

FXL File

Report.txt Tasklog.txt

Site.ini - Site.xml -
Site.xml.schema

Trimble GeoData

Remote Assistant

The Trimble Remote Assistant is a service that establishes a remote connection to the field controller

JRNENEEFIENEN

SEN

x

x <

IR SR NEIRN

X <

RN

Connected Community
service

Do nothing
Download to the controller

Upload to the Trimble
Connected Community
service

Do nothing
Download to the controller

Upload to the Trimble
Connected Community
service

Upload if file size is different

Download to the controller

Upload to the Trimble
Connected Community
service

Do nothing
Download to the controller

Upload to the Trimble
Connected Community
service

Download if file size is
different

for Trimble Support purposes. The controller must be registered in the Connected Community
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5 Data Management

Device Manager of the user organization. To do this, see Registering the controller, page 40.

To start the Remote Assistant service:

1. From the Trimble icon menu, tap System Info.

2. Tap Start Trimble Remote Assistant to establish the connection to the office. Asmallicon in
the status bar shows that the connection is successful.

Note — Trimble Remote Assistant is available only on Trimble TSC3 controllers.
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CHAPTER

Measurement Workflows

In this chapter:
= Displaying cut/fill
= Checking a grade/elevation
» Checking material thickness

= Measuring a surface or a feature

The SCS900 software is a site measurement tool
that enables you to monitor earthworks and
surface finishing operations. It enables
construction contractors to measure material
volumes, monitor grades and laid material
thicknesses, and to perform site measurement
tasks such as points, lines, and surfaces.

Displaying cut/fill

If the software is not in Measure mode, tap the
Home button and then tap Measure. Walk
anywhere on the design surface and view the
current cut/fill on the Info bars, page 31. The
lightbar on the left side of the screen indicates
whether the surface is in cut, fill, or on grade.
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6 Measurement Workflows

Checking a grade/elevation

Measure a surface point at a location where you want to view and record the difference in elevation
between the design surface and the actual ground.

1. If notin Measure mode, tap the Home button and then tap Measure.

2. Tap Measure to record a surface point and the cut/fill value at that location.

The software draws a box of the size that you specify around every recorded point so you can easily
view where data is missing.

As you move around, the values in the boxes at the top of the screen update.

Once a point is recorded, a colored box appears around it, showing it as in tolerance (green), cut
required (red), or fill required (blue).

To change the cut/fill tolerances:

1. Tap the Trimble icon menu and then tap Settings / Measure Settings.

2. Enter therequired tolerances and then tap Accept.

Tip — If a gray box appears, tap the zoom window icon and draw a box around the area of the gray box. Gray
boxes appear when the map is zoomed out too far to see the colored boxes at the specified resolution.

1o

If no boxes appear, tap from the toolbar on the right. Ensure that the Coverage Grid check
box and the Cut/Fill option are selected. You can also change the grid size.
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6 Measurement Workflows

Checking material thickness

The typical procedure for checking a material thickness is:

Measure the existing surface before laying the material.
Save the measured surface as a design.
Create a new work order and then select the saved design as the design.

Lay the new material.

vk wN e

Check the material thickness.

If the current material thickness is too thin, a blue square appears to show that more “fill” material
is required. If the current material thickness is too thick, a red square appears to show that material
is required to be “cut” away. If the current material thickness is within a specified tolerance, a green
square appears to show that no action is required.

1. If notin Measure mode, tap the Home button and then tap Measure.

2. Tap the Trimble icon menu and then select Settings / Measure Settings.

3. Enter therequired thickness as a surface offset (you can change tolerances here too).
4

Tap Measure to record a point and the cut/fill value at that location.

As you move around, the values in the boxes at the top of the screen update; the thickness of the
material is shown in the Thickness box.

Once a point is recorded, a colored box appears around it showing whether it is within the tolerance
range or whether more or less material is required.

Tip — If a gray box appears, tap the zoom window icon and draw a box around the area of the gray box. Gray
boxes appear when the map is zoomed out too far to see the colored boxes at the specified resolution.

If no boxes appear, tap a from the toolbar on the right. Ensure that the Coverage Grid check
box and the Cut/Fill option are selected. You can also change the grid size.

Measuring a surface or a feature

1. Ifthe softwareis not in Measure mode, tap the Home menu and then tap Measure.

g ROE g e

2. Taptheicon highlighted above to choose between point and line and surface and non-surface
feature to be measured:
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6 Measurement Workflows

Measure Type 1
| Point \Q Existing Line \| New Line

Point name: Topo21

Point code: SH|

Point type: Surface 3
Show every time: No 3

3. You can also enter a point name (will be automatically incremented) and point code. The status
bar icon changes depending on what kind of point or line you choose to measure:

Definition

Surface Point Elevation is used to create a terrain

model.

Feature Point Elevation is not used to create a

terrain model.

Feature Line or Area Elevation is not used to create
terrain model.

Breakline, Volume Boundary, or Outer  Elevation is used to create a terrain
Boundary model.

o
EEEEo
S

To create an outer boundary, volume boundary, or surface points to add to an existing line, select

the correct line type. Once a surface is measured, you can save the surface as a design and then
perform a material thickness check.

To save the surface as a design:

1. From the Home menu, tap Import/Export.

2. Tap Surface as Design.
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6 Measurement Workflows

Measuring with feature codes — Advanced Measurement module
required

The software can use feature codes to record data on site. Create and customize the feature code
library using the Feature Definition Manager of the Business Center - HCE software.

The feature code defines if a point, line, or breakline is measured. The following classes of feature
codes are available:

Feature code class Definition

0 Point feature, but no surface feature.
o Line feature, but no surface feature.
0 Point feature and surface point.

- Line feature and breakline.

Feature contains optional or compulsory attributes.

g

The currently selected feature code and its class can be identified in the status bar. To select and

manage feature codes in the field, tap

i T

4 | IAEE | psnElv:--- | Elv:--- | Thickness:---  p

® B o E Code filter: All v

e 13 BD | BL | BU | €L | con | cP @
EDP | CT || EOP [ FH FLL | FLR || FWS | GCK
FH oB
| GP ‘ e ma | OB en | pp
TDL
@ Pve RP | Rs | s | st | ss| t
TR L

Mmm 2 TcK | TOL TB'E* 1\
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6 Measurement Workflows

Select this option... to...

@ filter by group or category.

@ toggle to the Grid view.

@ drag code to the Quick Select list.
@ select from the Quick Select list.
@ select a feature code.

To select a feature code, either tap on one of the buttons in the Quick Select list or select a feature
code from the Grid view. The Grid view enables you to measure data without seeing the map.
Instead you have up to 34 codes to choose from with a single tap.

Both the Grid view and the Quick Select list selection enable you access feature codes quicker by
filtering feature codes by group and category. Groups and categories must be defined in the Feature
Definition Manager in the office.

A category is a class of related feature codes, for example, vegetation. For certain measurements or
tasks, you might want to group feature codes from different categories into a group for faster
access.

With each feature code, different attributes can be stored, which enables you to describe a recorded
point or line with more information. Attributes need to be set up in the Feature Definition Manager
and cannot be changed or created in the field.

Different properties can be applied to each attribute, for example, if it is optional or compulsory to
fill out this attribute, which values are required for this attribute, the permitted length of the text
string that you can enter, or available items in a drop-down list.

Photos

Photos can be attached as an attribute using the internal camera of your site controller.

The pictures are geotagged using the position of the internal GPS of the device or the position of an
external SPS GPS receiver, if available. Photo attributes are set up in the Feature Definition Manager.
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CHAPTER

Volume and COGO

In this chapter: When collecting data in the field, it is useful to be

= Compute Volumes able to review and edit your data. This section

covers reviewing and editing any surface data you

have measured, calculate new points and lines in

= Create Points/Arcs the field, and calculate the volume from measured
data.

s Review & Edit Data

= Enter/Edit Stakeout Points
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7 Volume and COGO

Compute Volumes

Use the Compute Volume option to calculate a volume from the data you have measured. Three
types of volumes can be calculated:

e To adesign surface

e To an entered elevation

e To asurface created by the volume boundary (stockpile/excavation volume)

From the Review & Edit Data menu, (see page 53), tap Contour Measured Surface to view
contours based on the surface you have measured. This is a useful tool to check for any major
errors. The contours highlight any elevation errors in the data.

1. Inthe Elv. Intervalfield, enter a contour interval and then press Enter.

P
a

2. Tap the Compute Volume icon .<E-:> .
3. Tap onthe boundary of the area for which you want to calculate the volume and then tap OK.
4. Select the type of volume to compute:

a. Thevolume from the surface you have measured to the design surface.

b. Thevolume to a user-defined elevation.

c. Thevolume of a stockpile/depression.

5. The following screen shows the result of the volume calculation. A depression or shrinkage
factor can be entered to accommodate for material expansion or shrinkage.

.astockpile .
EE_xpan_sion 0.000% _

Lt -~

<} Expansion
o— Shrinkage

00
m

>

4+
¥

B PP LY

o©

ey |

200 usft

h:-:-:-:-:-:-:l
~ Cancel Accept |
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7 Volume and COGO

[ -]

Save Computation

Description: |Stockpile 1

Volume type: Stockpile/Depression Volume
Expansion factor: 0.00%
Total cut volume: 9776.466 cu yds
Total fill volume: 0.036 cu yds
Net cut balance: 9776.429 cu yds
Base area: 34784.479 usft?
Base perimeter: 1219.060 usft
Surface area: 38446.308 usft?
Boundary: 20mmSTONE

" cancel Accept

The results of the calculation are stored in the site report using the name of the volume
boundary.

Trimble SCS900 Site Controller Software User Guide 49



7 Volume and COGO

Review & Edit Data

Use this feature to delete points you may have incorrectly measured. You can also use this feature
to calculate volumes of any surfaces that you have measured.

It also enables you to display contours of the surface, which serves as a quick check that you have
correctly collected data.

<=E

Review & Edit
Data

From the COGO menu, tap Review & Edit Data

The Review and Edit Surface screen has a list of icons on the left side, which represents all the
available functions:

Icon Description

i
e

3t

Compute Volumes

u

Wi~z @ =2] &

Create Line/Boundary

Delete Point/Line

Generate Measured Contours

Delete Measured Points and Lines

Compute Distance

Compute Total Distance

Compute Area
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7 Volume and COGO

Icon Description

Compute Down and Out from Line

'i-.
E Compute Angle
o

Icon Help

To undo an action, tap

Create Points/Arcs

Use the Create Points/Arcs option to create design data in the field. You can create new points
relative to other points and lines in the work order or in the current loaded design.

Create
From the COGO menu, tap Create Points/Arcs |__"2ns/Arcs

Avariety of functions is available in the bar on the left:

Icon Description

Create a Radius Point for an arc.

)

I““ﬂ Create Offset Points from a line.

il

I o Create an offset point at a certain station.
o-0-0 Create a mid-point of a line or arc.
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Description

Subdivide a line or arc in segments.

Create a point at a distance and bearing.

.
o (s§ "8

Enter the coordinates of a stakeout point.

>
=<
N

Create points at the end of a line or arc.

-~
—

Free Point Pick.

Toggle display bar.

Create a point at the intersection of a line.

Tells you In and Out of a point from the Line.

Delete Points and Lines.

Create an arc from three points or two points and radius.

Create a new line from two points.

Icon help.

D] Da e v e ]

The points can be stored as stakeout points or as measured points. A surface can be generated from
measured points, which you can export to the GCS900/Accugrade Grade Control Systems for
machine guidance.

Trimble SCS900 Site Controller Software User Guide 52



7 Volume and COGO

Enter/Edit Stakeout Points

Use this feature to retrieve a list of all stakeout points in the currently loaded design. Tap Edit, Add,
or Find to make changes or to completely delete the point.

B
Enter / Edit Stakeout Points

Name |C | Northing | Easting \ EF
IS3 MH 2312706.055 usft 947480.027 usft 4(
1S4 MH 2312277.129 usft 948344.170 usft 4(
IS5 MH 2312393.728 usft 947142.412 usft 4(
IS6 MH 2312783.360 usft 947215.857 usft 4(
IS7 MH 2312861.096 usft 947035.906 usft 4(
IS8 MH 2312790.022 usft 947907.469 usft 4(
LP1 LP 2312944.291 usft 948047.874 usft --
LP2 LP 2312384.189 usft 946565.047 usft --

-
4| | *

Edit... Add... Find... Delete... |

Cancel

Trimble SCS900 Site Controller Software User Guide 53



CHAPTER

Stakeout Workflow

In this chapter: The SCS900 software enables stakeout points,

= Points lines, surfaces and roads stored in a design. You
can access the Stakeout menu either through the
Home menu, or tap and hold on items in the

= Lines Measurement screen.

= Stakeout Settings

» Slope staking
s Reference Line
s Surfaces

= Roads
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8 Stakeout Workflow

Points

Before you can stake out points, the points must be part of the currently loaded design. There are a
number of ways to get points into a design:

Enter the coordinates of the point in the SCS900 software using the Enter/Edit Stakeout Points
functions.

Use the Create Stakeout Points COGO functions.

From the Measurement screen, tap the Home button and then tap Stake.

Select a point using the list at the top right of the screen and then select a stakeout point in the
Points tab. Alternatively, select the point directly from the map. If there is more than one
object available in this area, a list of different objects appears that you can select from.

The following symbols distinguish the different stakeout items:

Icon Description
o Points
- Lines
A Roads
Py Surfaces

If you need to calculate a stakeout point from design data, tap the Home button and use the
functions in the COGO menu.

Multiple stake methods (point, side slope, and catch point) are available. For information
about slope staking, see page 62.

Use the values in the info bar (for example, GO) to navigate to the point. A small green arrow
between your current position and the stakeout point provides you with guidance. In addition,
a large arrow on the top right of the screen turns in the correct walking direction after the
software recognizes in which direction you are currently moving. When using a map rotation in
travel direction or following a selected alignment, an additional North Arrow on the top left
indicates North so that the values in the info bar can be used to navigate to the point.

When you are close to the stakeout point, the software switches into the Fine Stake mode.
Additional guidance arrows appear on the top right corner of the map to indicate the remaining
distance in each direction. The screen is orientated to the last moving direction before the Fine
Stake mode was selected.

Once you are within tolerance, the dot in the circle of the stake guidance turns yellow. After

tapping Stake, a stakeout report for this point appears. The software remembers which tab of
the stakeout report was last viewed and opens the same tab after staking the next point.

Select the Edit stakeout name check box to store the staked point using a different point name
and point code.
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9. Inanothertab, a graphical diagram shows how to put an elevation mark on the stake. The
software does all the calculations for you. The way that the software calculates the elevation
mark and cut/fill depends on the stakeout settings in the Trimble icon menu.

10. After staking out the point has been completed, the software returns to the Stakeout Selection
screen. If during the stakeout process a different point is selected, tap the Trimble icon menu
and then tap Change Stake Object

11. To change the stakeout elevation to a different value, tap the Trimble icon menu and then tap
Stakeout Elevation

L

Stakeout
Elevation

Stakeout Settings

To access these settings, from the main menu, select the Trimble icon menu in Stakeout mode and
tap Stakeout Settings. The software supports three elevation reference methods used to mark cut
depths or fill heights on a grade stake or location/grade stake:

e Moeasuring the cut/fill reference mark from the ground surface
e Moeasuring the cut/fill reference mark from the top of the stake

o Cut/fill reference from the measured point

These methods help you to establish a cut/fill reference mark on the stake at a specified cut/fill
measurement interval, such as at one-foot increments. If you choose to place a cut/fill reference
mark on the grade stake, a Stake Marking report helps you establish the position of the reference
mark on the stake and helps you correctly label it.

Typically, you will use one of the above methods consistently. Usually, you use only one method.
When you first receive the software, switch to the correct setting. The software then uses that
setting for all stakeout operations. When you tap Stake during a stakeout operation, the software
converts the measured elevation, design elevation, and computed cut depth or fill height into
information that you can then write on the stake. It also informs you where to mark the stake based
on the settings that you enter in this dialog:
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-Stakeout Settings
Horizontal tolerance: W
Stake marking method: \Ground Surface v |@
Working stake length: 2.625 usi|(2
Cut/Fill interval: |0.656 usft

Min. bottom of stake spacing: 0.820 usft
Min. top of stake spacing: 0.820 usft

Cancel

The stakeout tolerance is also entered in this dialog.

Note - You can only stake a point or location when you get close to the point to stake, at which
time the Stake button appears on the map view.

Measured Point

This method enables you to label a grade stake with the required cut depth or fill height as
measured from the measured point, which can be either the top of stake or the current ground
surface. If you choose to mark the stake with the cut depth or fill height as referenced to the
measured point, the software simply informs you of the cut or fill measurement. In this case, you
can mark that measurement on the stake, using your normal convention to indicate from where the
measurement is referenced.

Ground Surface

With this method, the software guides you to the horizontal location of the stakeout point. The
software generates a Stake Marking report that shows the distance from the ground up to where
you must mark the stake. It also shows the value of cut or fill to mark on the stake.

Top of stake

With this method, the software guides you to the horizontal location of the stakeout point. You
then hammer the stake into the ground and measure the top of the stake. You can change the
antenna height for this measurement in case you want to take the receiver off the pole and place it
directly on the stake. The software shows the distance from the top of the stake down to where you
must mark the stake. It also shows the value of cut or fill to mark on the stake.
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Lines

The lines you want to stake out must be part of a design map in the currently loaded design. There
are multiple ways to get lines into a design:

e From a DXF foreground map with lines created in the Business Center - HCE Software.

e By creating lines from points using the COGO functions

1. From the Measurement screen, tap the Home button and then tap Stake.

2. Select a line using the list at the top right of the screen and then select a stakeout line in the
Line tab. Alternatively, select a line directly from the map. If there is more than one object
available in this area, a list of different objects appear where you can specify your selection.
When using the Business Center - HCE software, names can be assigned to lines, which
improves the orientation.

Object: W

Stake method: [Obiect -
<Topol8 =l
% A New Vulcan (CL)
< (Unnamed DXF)
<" New Vulcan (CL)
< (Unnamed DXF)
—~CPR
" |~DITCHR
~SHLDR
«~CURBR
~BOXR =

L Al adlV o gl Al og

" cancel i |

3. If necessary, before confirming the selection, change the line direction using the button on the
top right of the screen.

4. Different stake methods (side slope and catch point) are available. See Slope staking, page 62.

5. Enter the station to be staked out or tap on the line where you want to stake it and then tap
OK.

6. The map view then guides you to the point. To help you find the point, the guide arrow needs
to point up the screen to show that you are traveling directly toward the point. You can turn
the guide arrow off and on. The information bars at the top of the screen can be customized
using the Customize Info Bars option in the Trimble icon menu. The display shows the design
elevation for the point, the amount of cut or fill required to get to that elevation, and how far
and in what direction you need to travel to get to the point.
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7. The default map view has the direction north pointing up. You can change this so that the
guide arrow is pointing in the direction you are walking by changing the map rotation in the
Map Options dialog. A cut/fill lightbar on the left graphically shows cut and fill.

8. When you are close to the selected line point, the software switches into the Fine Stake mode.
Additional guidance arrows appear on the top right corner of the map to indicate the remaining
distance in each direction. The screen is orientated to the last moving direction before the Fine
Stake mode was selected. When you are within tolerance, the dot in the circle of the stake
guidance turns yellow.

After tapping Stake, a stakeout report appears. The software creates a Stake Marker report. A
graphical diagram shows how to put an elevation mark on the stake. The software does all the
calculations for you. The way the software calculates the elevation mark and cut/fill depends on
the stakeout settings in the Trimble icon menu. The software remembers which tab of the
stakeout report was last viewed and opens the same tab after staking the next point.

Instead of staking a certain station it is also possible to stake a line at random stations using the
buttons on the bottom right in the status bar:

to

Tap
II stake at fixed intervals starting at a certain station

stake at random intervals somewhere along the line

9. Enter a horizontal and vertical offset for the stakeout line. The line elevation can be defined
using different methods and the start station, station interval (increment distance), and
whether or not to automatically advance to the next station can also be determined. If a
horizontal offset is applied and the Generate tangent/corner points check box is selected,
three stakeout points are created at each corner to help you stake out the lines. Access these
settings from the Trimble Icon menu under Settings / Line settings.

Slope staking

For both stakeout point and stakeout lines, side slope and catch point stakeout modes are available
that enable staking out the slope or the catch point between this slope and the existing ground. This
function can be applied to any earthwork operation that involves a tie to the current ground
surface. Examples include staking earthworks for pad placement, earth dams, site drainage, ponds,
lagoons, embankments, and keyways.

The tie-slope can be projected from a 3D point using a bearing or from a 3D Line. After defining
either one of those, the stakeout process is very much alike. Use the Define Side Slope dialog to
select the direction of the slope and whether you define a cut and/or fill side slope to the left or right
of the reference line. To select what the slope designation is to be based on, alter the selection in the
Slope direction field.
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I
Define Side Slopes

Cut slope: 100.00% t'
Fill slope: 100.00% v
Slope direction: Left ﬂ

Cancel

The software computes the elevation of the reference line at that point, and projects the designated
cut and/or fill side slope magnitudes from that reference point, through your position, along a line
referred to as the slope indicator. The slope indicator line is shown in the map view, extending from
the reference line to the currently predicted catch point location. In predicting the location of the
catch point, if you have defined both cut and fill slope magnitudes, the software determines
whether the cut slope or fill slope is applicable at the reference point.

When staking building pad side slopes, the building pad has both internal and external right-angled
corners. If you are staking external corner points, then the software automatically calculates the
side slope as projected radially from the corner point. At an internal corner, the software calculates
the catch point at a bisectional angle.

The Catch point option enables you to stake out points where the side slope intersects the ground
surface as it is found to exist. As you stake catch points at fixed intervals, you should adapt to the
existing terrain and be aware of the effect that it may have on the location of the daylight line. You
can freely switch between the Stake at fixed intervals mode and Stake at randomly chosen interval
modes.

The Line option enables you to stake out the side slope’s reference line. The software guides you to
the line at the nearest point to where you currently are, or to a specific station. The Side Slope
option enables you to place a grade stake at any required location on the side slope between the
reference line and the catch point. You can toggle between the different stakeout methods using
the button at the right of the status bar. Tap on the icon on the right of the status bar:

Icon Description

Stake catch point

Stake side slope

Stake line

|
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Reference Line

While staking out different objects like a point, line, surface or road another line or alignment can be
selected and referenced. To select a reference line or alignment, select the Reference Line option in
the Trimble icon menu after defining the primary stakeout object. Select the reference line from the
map.

When a lineis used as a reference line, an optional horizontal offset and a line start station can be
applied.

Reference Line Settings

Line start station: 0.000 usft
Horizontal offset: 0.000 usft

& Left
“ Right

The station and offset to this reference line can be displayed in the info bar as reference station (R.
Sta) and reference offset (R. Off) while staking the actual object.
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Surfaces

Use the Stake Surface feature to put grade stakes over a design surface indicating the cut/fill to it.
The surface you want to stake out must be part of the currently loaded design. There are multiple
ways to get a surface into a design:

e From a TTM surface file (this can be created in the Business Center - HCE software).

e By creating a surface design from an existing SCS900 work order using the Import/Export
feature.

1. From the Measurement screen, tap the Home button and then tap Stake.

2. Select the surface using the list on the top right of the screen and then in the Surface tab select
a stakeout surface.

3. Usethevalues in the display bar to indicate the current cut/fill.

4. After tapping Stake, the software creates a Stake marker report. A graphical diagram shows
how to put an elevation mark on the stake. The method that the software uses to calculate the
elevation mark and cut/fill depends on the Stakeout Settings in the Trimble icon menu.

Roads

The road or alignment that you want to stake out must be part of the currently loaded design.
There are multiple ways to get a road into a design:

e From aroad corridor created in the Business Center — HCE software and exported through the
Field Data menu.

e Convert LandXML files with the SCS Data Manager.

e Export aroad from the Terramodel® software.

If you have the Road module installed and a Road design loaded, you can select a road/alignment
from the map or from the list in the Stake menu and select one of the three road staking methods
that are available:

o Roadway feature staking(see page 66)
¢ Catch point staking(see page 70)
e Location on Surface(see page 71)

If no Roading option is installed on the controller, a warning appears.

The grade stake marking preferences in the Stakeout Settings also apply to staking roadways.
Staking methods for catch point staking can be set in the Trimble icon menu under Settings / Catch
Point Marking while in the Catch Point staking mode.
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Roadway feature staking

1. From the Measurement screen, tap the Home button and then tap Stake.

2. Select a road or alignment using the list at the top right of the screen and then select an
alignment in the Road tab. Alternatively, select an alignment directly from the map. If there is
more than one object available in this area, a list of different objects appear where you can
specify a selection.

3. Enter a station or select one from the map at which to stake out the road feature. A cross
section of the roadway appears. It notes the location of each roadway feature as a node on
that cross section. The Select Roadway Feature screen appears.

4. Select the roadway feature node that represents the roadway feature that you want to stake
out. To select a node, do one of the following:

e Select from a node list (tap in the top right corner).

e Tap therequired node.

1+

B a0 2Ll M

[
ESeIect Roadway Feature

Select Feature

¢

20 usft

Cancel ' [ Accept

Ifthe node is on the finished grade model, the name of the node would be SHLD, for example. If
the node being selected is on the subgrade adjusted surface, it would be named SHLD-0.250;
meaning it is the SHLD node, but it has a -0.250 m. A subgrade can be entered by accessing
Road Settings through the Trimble icon menu while in Road Stakeout mode.
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[+
ESeIect Roadway Feature =]

Select Feature

Koo pLlels e

20 usft
h:-:-:-:-:d

Cancel

If you are navigating up station, the normal cross section view is displayed left to right as
expected. If however, you are navigating down station, then the cross section would normally
be back to front. To reverse the view of the section, make sure Road Stakeout mode is selected,
then select the Trimble icon menu / Road Settings, and change the view setting to up station or
down station.

5. Let the software guide you to the point to be staked on the selected feature using the values in
the info bar. To help you find the point, the guide arrow needs to point up the screen to show
that you are traveling directly toward the point. You can turn the guide arrow off and on. The
information bars at the top of the screen can be customized using the Customize Info Bars
option in the Trimble icon menu. By default, the info bar shows the design elevation for the
point, the amount of cut or fill required to get to that elevation, and how far and in what
direction you need to travel to get to the point. You can scroll through the different values
using the black arrows on either side of the info bar. The default map view has the direction
north pointing up. To change this so that the direction you are walking is pointing at you,
change the map rotation in Map Options. A cut/fill lightbar on the left graphically shows cut
and fill.

6. When you are close to the selected node, the software switches into the Fine Stake mode.
Additional guidance arrows appear on the top right corner of the map to indicate the remaining
distance in each direction. The screen is orientated to the last moving direction before the Fine
Stake mode was selected.

7. After tapping Stake, a stakeout report appears. The software creates a Stake Marker report. A
graphical diagram shows how to put an elevation mark on the stake. The software does all the
calculations for you. The way that the software calculates the elevation mark and cut/fill
depends on the stakeout settings in the Trimble icon menu. The software remembers which
tab of the stakeout report was last viewed and opens the same tab after staking the next point.

Instead of staking a certain station, you can also stake an alignment at random stations using
these buttons on the bottom right of the status bar:
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to...

Tap...
II stake at fixed intervals starting at a certain station.

stake at random intervals somewhere along the line.

8. Setthe Auto advance option field to one of the following options using the Road Settings
dialog in the Trimble icon menu:

To move to the... select...

next station automatically advance to the next station.

previous station automatically advance to the previous station.

Do not automatically advance. This option maintains the current station
between points, and enables you to increase or decrease the station
when you are ready.

No (not move a Depending on the settings for Station Interval, SCS900 will or will not
station) advance to the next station.

Simple feature offset

When staking a feature, an offset is usually applied. The software is extremely flexible in the way that
it enables you to specify an offset.

After selecting roadway feature node (Step 4 above) tap the button with the stake and the two red
arrows on the top right of the screen. The Define Feature Offset screen appears. The second line
enables you to specify the fixed horizontal offset or select a random horizontal offset. When
specifying a fixed offset, a red line and a circle shows you where that offset point is. When specifying
a random offset, you can stake anywhere along the cross section; the software displays the results

to the point you are at:

[
Define Feature Offset
EFixed Horizontal Offset 0.000 usft

EDefine Grade In nnos.

0XCL

B &2 L L% «

20 usft
h:-:-:-:-:-']
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e Thethird line enables you to specify the kind of offset you want to use. Define Grade enables
you to specify a slope for the offset. A grade of 0.000% is horizontal.

e Thered, yellow, green stake on the top right of the screen enables you to apply the offset from
a different feature node instead of the selected feature node itself.

Custom feature staking

Instead of staking a roadway feature node, you can define your own custom feature on a cross
section. One example could be where the subgrade intersects with the tie slope. Follow these steps:

1. While in the Roadway Feature Selection screen, select the Define Custom Feature option:

=
¥

[
EDefine Custom Feature =

Select Line Start Point =y =|

+
»
+

Eaopp.

20 usft
h:-:-:-:-:-']

 Cancel - Accept -

2. Select two feature nodes that will form the subgrade. You can access subgrade adjustments of
the finished grade from the map view during stakeout (access the Road menu through the
Trimble icon menu, and then enter the amount and direction for the offset).

3. Select a segment (e.g., the tie slope). If required, enter a vertical offset for this segment and if
you want to apply the offset vertical or perpendicular.

4. Astake appears where this subgrade intersects the tie slope. Stake out this point as usual. You
can also specify a horizontal offset for the stake the same way as a normal roadway feature.

Custom segment staking

Instead of staking a roadway feature node, you can define a custom segment on a cross section. A
segment is defined as the surface between two roadway feature nodes with an optional offset to
reflect a subgrade. One example could be where a dam of a road gets build in multiple layers
without having the complete shape of the finished grade. With this layered lift function, you can do
the following:
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1. While in the Roadway Feature Selection screen, select the Define Custom Segment option.

2. Select two feature nodes that will form the subgrade. If required, enter a vertical offset for this
segment and if you want to apply a vertical or perpendicular offset.

3. You will get guidance to the first point you have selected. Stake out this point as usual. You can
also specify a horizontal offset for the stake the same way like a normal roadway feature. It is
also possible to enter a random offset and apply the grade of the roadway and then stake this
layer infinite to the left or to the right and get the cut/fill to this segment.

Catch point staking

Catch point staking from the Road menu operates in an almost identical way to the catch point
staking associated with the side slope function. The only difference is that the tie slopes are defined
in the road model itself, and are automatically displayed. In a typical road model, there are at least
two tie slopes; one for the right and one for the left side of the road. In the case of a divided
highway, it is common to find four tie slopes, one for the left and right of each of the two traveled
ways.

1. From the Measurement screen, tap the Home button and then tap Stake.

2. Select aroad using the list at the top right of the screen and then select an alignment in the
Road tab. Alternatively, select the road alignment directly from the map. If there is more than
one object available in this area, a list of different objects will appear where you can specify a
selection.

3. Select a stake method catch point.

4. Enter a station or select one from the map at which to stake out the road feature. A cross
section of the roadway appears unless no tie slopes where defined for this cross section. You
can then choose to extend the outer segments of the road and use them as tie slope instead.

5. Select if you want to stake the tie slope of left or the right side of the road by tapping on the tie
slopeitself or using down arrow on the top right. The selected tie slopes as defined in the road
model (a cut slope shows in red and a fill slope shows in blue) will be highlighted.

[r - |
Pick a Slope Roadway 0 Right Cut Tie E

Cut: 50.00% Fill: ---

&
Ck.
\/ﬂ,’,@\‘—/r_’\/g
o
B

20 usft
h:-:-:-:-:-‘

+
»
+
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In the top line of the display, the roadway that the tie slope is associated with is displayed. In
the example above, there is only one roadway in the selected road job, and that was not
named—hence Roadway O is displayed.

Navigate to the correct station using the Ahead/Backward values in the info bar. Then toggle
the cross section view using the bottom icon in the map control bar and walk toward the tie-
slope you are going to stake.

The software calculates the intersection between this recreated surface and the tie-slope and
provides you with guidance to this point by extending this surface toward the slope. This point
is dynamic and changes depending on the way you walk and how the terrain is formed. Use
inward/outward to find the actual catch point, but also keep an eye on the station.

Once you are in proximity of the point where the tie-slope intersects with the existing ground,
tap Stake.

The software creates a Stake Marker report. A graphical diagram shows how to put an elevation
mark on the stake. Depending on the settings for catch point marking in the Trimble icon
menu, you will get guidance to one or two more stakes which mark the point. Single Stake,
Dual Stake, and Batter Rail methods are available. The placement and marking of these stakes
is completely guided. The software remembers which tab of the stakeout report was last
viewed and opens the same tab after staking the next point.

Instead of staking a certain station it is also possible to stake a line at random stations using
these buttons on the bottom right in the status bar:

to...

Tap...
“ stake at fixed intervals starting at a certain station

stake at random intervals somewhere along the line

Location on Surface

Location on Surface is a very basic method of staking a road. You can walk over the road surface and
have the display showing station, offset, and cut/fill to this road surface or navigate to a certain
station and offset of this road.

1.
2.

From the Measurement screen, tap the Home button and then tap Stake.

Select a road using the list at the top right of the screen and then select an alignment in the
Road tab. Alternatively, select the road alignment directly from the map. If there is more than
one object available in this area, a list of different objects will appear where you can specify the
selection.

Select a stake method location.

Enter a station and offset or select one from the screen. You can also overwrite the design
elevation at this station.
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5. The map view then guides you to the point. To help you find the point, the guide arrow needs
to point up the screen to show that you are traveling directly toward the point. You can turn
the guide arrow off and on. The information bars at the top of the screen can be customized
using the Configure Info Bars option in the Trimble icon menu. The display below shows the
design elevation for the point, the amount of cut or fill required to get to that elevation, and
how far and in what direction you need to travel to get to the point. The default map view has
the direction north pointing up. You can change this so that the direction you are walking is
pointing up by changing the map rotation in map options. A cut/fill light bar on the left
graphically shows cut and fill.

6. When you are close to the selected line, the software switches into the Fine Stake mode.
Additional guidance arrows appear on the top right corner of the map to indicate the remaining
distance in each direction. The screen is orientated to the last moving direction before the Fine
Stake mode was selected.

7. After tapping Stake, a stakeout report appears. The software creates a Stake Marker report. A
graphical diagram indicates how to put an elevation mark on the stake. The software does all
the calculations for you. The way the software calculates the elevation mark and cut/fill
depends on the stakeout settings in the Trimble icon menu. The software remembers which
tab of the stakeout report was last viewed and opens the same tab after staking the next point.

8. Instead of staking a certain station, you can stake a line at random stations using these buttons
on the bottom right of the status bar:

to...

Tap...
II stake at fixed intervals starting at a certain station.

stake at random intervals somewhere along the line.

To toggle between Feature, Location, and Catch point staking, tap the right button in the status bar.
Tap the icon on the top right of the status bar:

Icon Description

;‘hl\ Feature

/R Location on Road Surface
+ Catch point

SN
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CHAPTER

Measuring with GPS

In this chapter: To perform these measurement tasks, you need

= Setting up the GPS base station the SCS900 site controller software running on a
controller that is either connected to a positioning
device like a GNSS system or a total station. This

» Calibrating the site chapter explains how to set up and use the
different components of a GNSS RTK system.

» Setting up the GPS rover receiver

= Measuring a new control point
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Setting up the GPS base station

For Precision RTK (Real-Time Kinematic) GPS operations, two main components are generally
required, a base station and a rover receiver. The two components are connected by radio (450 MHz
or 900 MHz frequency bands) over which RTK corrections are transmitted from the base station to
the rover receiver. The base station is set up in a fixed location where it tracks the satellites of the
GPS and, optionally, the GLONASS and QZSS constellations. The rover receiver moves around the
jobsite on a pole, backpack, vehicle, or earthmoving machine.

The first time that the base station is used on a project, it can be located at a known or unknown
point. Once the base station is set up, turn it on. The SPS Modular GPS receivers have a front panel
and keypad that enables the receiver to be initialized and set up without needing a controller;
however, this guide focuses on using the software to set up the base station.

The base station setup process remembers how the previous setup was made. It automatically
reconnects the components, selects the appropriate radio channel or network number, and then
automatically starts to transmit GPS positions. If the base station has never been previously
established on this site, or if on the last base station setup a cellphone was used to broadcast
corrections, you must completely set up the base station again using the options in the Select
Connection Method dialog. In these situations, the Setup radio only option is not available.

When using the SPS Smart GPS antenna or the SPS Modular GPS receivers, which use the
AutoBase™ technology, once a base station has been established the first time, if nothing is
changing between setups, you can simply set up the receiver at the base station location and then
switch it on. Using AutoBase technology, the receiver reloads all appropriate data, makes all
appropriate connections, and then starts to transmit corrections on the last used radio channel or
network number. This eliminates the need to use a controller with the software to set up the base
station each day. If you want the SPS GNSS receivers (SPS Smart GNSS antennas, and the SPS
Modular GNSS receivers) to operate in AutoBase mode, you must name each base station with a
different name, otherwise the AutoBase mode appears not to work.

To set up the base station:

1. From the Home menu, select GPS and then tap Connect.

| Receiver Setup

Mode: Base E
Connection type: Emulator E
Correction method: Radio in Receiver E
Network ID: 1 E
Base position: Lat/Long/Height E
Base name: Basel

Antenna: Zephyr Geodetic Mod]
Antenna height: |4.969 b|
Corrections: CMRx j

2. Setthe Mode field to Base and then answer each question to complete the base station setup.
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You only need to do this once; the software remembers your settings and prompts you to use the
same ones the next time you set up the base station. You can then change any of the base station
settings.

Setting up the GPS rover receiver
To set up the rover receiver:

1. From the Home menu, select GPS and then tap Connect.
[ -

Receiver Setup

Mode: Rover Z|
Connection type: Emulator Zl
Correction method: Radio in Receiver 3
Network ID: 1 El
Connected to base: Emulator 3
Antenna: Zephyr E@
Antenna height: 6.562 usft

 Cancel ' Accept

2. Setthe Mode option to Rover and then answer each question in turn to complete the base
setup.

You only need to do this one; the software remembers your settings and prompts you to use the
same ones the next time you set up the rover receiver. You can then change any of the rover
settings.

Calibrating the site

Global Positioning Systems (GPS) produce positions in latitude, longitude, and height coordinates.
Construction projects are generally designed in northing, easting, and elevation (or X,Y,Z) Cartesian
coordinates. A GPS site calibration ties the GPS positions to the local site coordinate system so that
GPS can be used to measure or stake out on the construction site. The site calibration process
involves measuring a number of known control points in the local site coordinate system using a
GPS rover, allowing the software to create pairs of measured latitude, longitude, height, and known
control points.

To calibrate the site:

1. From the Home menu, select GPS and then tap Site Calibration.

2. Ifyou have no control points in your site, you are prompted to enter a coordinate for where
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you are standing. The software computes a “one point” calibration based on this coordinate:

[~
No Control Point Calibration

Enter rover's local coordinate and press 'Measure' to

calibrate.

Geoid file: (Do not use geoid file) 3
Name: Start

Northing: 16404.167 usft

Easting: 16404.167 usft

Elevation: 328.083 usft

Static Mode Settings

Cancel @Ot Measure

3. If control points exist in your site, you are prompted to select a control point and then measure

the physical point on the ground with your rover receiver. To add a calibration point, tap Add
Point:

[
Site Calibration

3 or more measurements are required to compute the
calibration errors.

Point Name |H Residuals V Residuals

Point3  [v]--

4. When enough control points have been measured, horizontal and vertical residuals will appear
on the screen.

5. Ifthese are acceptable, tap Finish to end the calibration. The calibration is then used for the
site.

The site calibration is stored in a DC file that can be used with other Trimble equipment working on
the project. The software can also export the site calibration to a CompactFlash card as a CFG file for
use with Trimble GS900 machine control systems.
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The software notifies you after three points have been measured whether the calibration is in or out
of tolerance with respect to the calibration tolerances. After each point you have the following
options:

e measure additional points

o retake a point flagged as potentially in error

e save the partial calibration and resume later
The danger of using residuals as the only means of controlling a calibration is that the best
precisions can be achieved using the wrong combination of points in the calibration solution. When
an inclined planeis in use, this manipulation of residuals can result in a steeper tilt of the plane to
best fit the data, resulting in better precisions and an in-tolerance calibration. Monitor the tilt of the
plane closely, especially when the geometry of the control points is not strong. Widespread control
that covers the entire site is good; narrow-based control around a corridor is not as good. An

incorrect tilt of the plane can result in increasing errors in height as you move away from the center
of the controlled area.

Performing a two-point calibration

Trimble recommends that wherever possible you use a multi-point calibration. Use the two-point
calibration method in situations where a baseline of only two control points is available. In the two-
point calibration, the first point establishes the position and elevation for the project; the second
point establishes the project orientation.

In a two-point calibration, the heights for the project are computed using a simple block shift
method that ties all heights to the first measured control point. A two-point calibration is carried out
in the same way as a multi-point calibration.

Troubleshooting a site calibration

If a site calibration fails repeatedly, try the following solutions:

o Try a different combination of control points. The software cannot always identify the bad
point.

o Start the calibration process again. You may have incorrectly measured a point or points.

e Check the equipment. The source of the error may be as simple as the adjustment of the rod
bubble, or a bent rod.

Once the system is set up there are limited sources of error when using RTK GPS systems. The most
common sources of error include:

e Apoorsite calibration
e Incorrect base antenna height
e Incorrect rover antenna height

e Incorrect selection of the correct antenna type at the base or rover, which causes height errors
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Incorrect location of the base station antenna

e AGPSrod bubbleis out of adjustment or the rod is bent

These errors can easily be detected by rechecking the system setup. After starting the rover each
day, the software prompts you to recheck the system setup. All recheck system setup operations
are logged in the work order report and record files for reference and troubleshooting
requirements.

Measuring a new control point

There are several reasons why you may need to measure a new control point during a project and
then add the measured position to the control point file for the site. Typical cases include:

When operating the project with a mixture of GPS and total station equipment; total stations
require more control points around the project because of their line-of-sight dependence.
Control points can be established very rapidly using GPS and can be used later by total station
crews to establish their position and orientation.

When operating a site, a base station often needs to be moved closer to the current working
location to provide better radio coverage. The base station must be relocated to a known point
in the local coordinate system. Using the Measure control point option ensures that the point
is created in the correct location, with the correct coordinates, and guarantees that the site
calibration remains valid after the base station is moved.

When carrying out topographic measurements on a new site before control for the project is
established, you may set the base station up in an arbitrary and convenient location and then
carry out a single-point calibration. Once completed, measuring three or more control points
around the project provides a common set of reference points that can be used later to
transform the data measured using the single-point calibration, to the site coordinate system
once it is established.

From the Home menu, select either GPS or Total Station and then tap Measure Control Point.

Create the control point location using a stake, a hub, or a road nail as required and then mark
the stake with the name for the control point, for example, STNQ.

Set up the GPS rod over the point and hold it steady using a bipod. The software displays the
current GPS position on the map.

When you are ready to take the measurement, tap Measure. The measurement process takes
approximately 15 seconds to complete. Measuring for 15 seconds takes an average position
that increases the accuracy of the computed control point.

When each control point is measured, the software stores the control point data position in the
control point (Control.csv) file for the site, and also records the measurement data into the record
and report files for the work order.
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CHAPTER

Measuring with a Total Station

In this chapter: To perform measurement or stakeout tasks, you

= Connecting to a total station need the SCS900 site controller software running

on a controller that is connected to a positioning

device. This chapter explains how to set up and

= Establishing the station use SPS Series total stations with the SCS900
software.

n Leveling the total station

» Arbitrary location
m Setting up on a known point

m Reading station setup data from the total
station

s Completing a station establishment where
the height of the setup point has not been
determined

= Working with a mechanical total station
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Connecting to a total station

When you start the software, it automatically looks for a connection to the total station through a
cable connection. If the instrument is a robotic total station, the connection can also be made
through the internal radio of the controller or an external 2.4 GHz radio. When the connection is
made, the Level Compensator screen (see page 80) appears.

If you leave the controller in GPS mode, it cannot find the connection even if it is connected directly
to a total station. If you are using Bluetooth wireless technology to connect to the total station
(SPS700, SPSx10, SPSx20 or SPSx30), you must first turn on the total station, enable the Bluetooth
connection using the face 2 display menu, and then manually force the connection to it.

If you are using a radio to connect to the total station, you need to manually force the connection
toit.

To force a connection using either a radio or Bluetooth wireless connection:

Go to the Trimble icon menu and select Total Station.
Select Trimble as a Brand.

Select SPS Series as instrument.

Select Bluetooth or Radio.

Select the Radio channel and Network ID.

o v s w N E

Follow the instructions that appear on the screen.

Leveling the total station

The compensator inside the total station provides dual-axis correction for any mislevel of the
instrument during operation, for a working range of up to 6' of arc. The display enables you to level
the total station accurately using the foot-screws on the tribrach:

[
Level Compensator - Uninitialized

Compensator

& Enabled

© Disabled

J Sighting:

0° 00' 00"

Trunnion: Q° 00' 00"
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To level the total station:

Align the front face of the total station with two tribrach foot-screws.
Adjust the horizontal bubble in the display using those same two foot screws.

Adjust the vertical bubble using the third foot screw.

> w N

Once level, tap OK.

You can disable the compensator, however, only do this in extreme working conditions such as
when working:

¢ in close proximity to a piling rig, vibratory compactor, or other source of extreme ground
vibration that would continuously affect the compensation effect on the total station.

e on amobile platform where the level is continuously changing, but where all measurements are
needed in the reference frame of the platform itself, for example on a marine vessel or oil
platform.

o in extremely windy conditions where wind buffet on the total station is significant, and again
would continuously affect the compensation of the total station.

If the compensator is switched off, the total station stops correcting for instrument mislevel. In
these situations, watch and adjust the level on a regular basis. At this point, Trimble assumes that
the total station is set up accurately over a known point (see page 83) or that you have setitupin a
convenient location, and will establish its position using the Arbitrary location (see page 82).

Establishing the station

The total station position and orientation is necessary if the total station is to be used for site
measurement or stakeout operations where the positions computed are related to a site coordinate
system. There are two methods of establishing the position and orientation of the total station:

o Arbitrary location (see page 82) (also known as free station or resection)

¢ Setting up on a known point (see page 83)

Once the station has been established, the total station can be used for measurement or stakeout
operations.

If you have not established the position of the total station and you select a measurement or
stakeout function, the software automatically forces you into this process when connected to a
total station. If you have not entered any control point data for the site, the station establishment
process only allows you to set up at a manually entered coordinate location and orientation of the
angle system to 0.0000 in a chosen direction. This method is acceptable only if you are measuring a
new site that has not been measured before and provided that you are not trying to measure or
stake anything from a loaded design. In most cases, you should have control points available.
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Arbitrary location

The arbitrary location setup enables you to set up the total station at a location that is convenient
for the operation to be carried out (and not over a known point). It measures the angle and distance
to two or more known points to determine the position and orientation of the total station.

1. Inthe Total Station menu, select Station Setup. If you just connected to the total station, the
software prompts you for the station establishment method. Select the Set up on a known
control point option:

Total Station Setup

© Set up at an arbitrary location
& Set up on a known control point
© Read station setup data from instrument

© Use last setup

Cancel Accept

2. Select an instrument point from the list or map.
Enter the instrument height.

4. Add at least one control point:

Known Station Setup

Setup error is in tolerance.
HA: 0° 00' 00" HD: --- Delta Z: ---

Add Point | Settings | Report |

Point Name  HA Error HD Error |VD Error DeltaN Dg
v]A RefPt -

Cancel

The screen shows if the setup is within or outside the tolerance.

5. Tap Accept to complete the instrument setup.
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Setting up on a known point

This enables you to set up the total station over a known control point location and then measure
to one or more reference control points to establish its position and orientation on the jobsite. In
most cases, a single reference control point may be all that is required. In other cases, where the
accuracy of the work is higher, measuring more than one reference control point can provide better
control over the orientation of the total station and a further check that the control point at the
total station position or any of the measured reference control point locations has not moved.
Unlike the arbitrary location method, once you measure a single reference control point, the
information shown below appears on the screen. You can follow similar steps to those used in the
arbitrary location method of station establishment. Select from one of the following options:

1.

From the Total Station menu, select the Station Setup option. If you have just connected to
the total station, the software prompts you to select the station establishment method. Select
the Set up at an arbitrary location option.

[
Total Station Setup
¢ Set up at an arbitrary location
# Set up on a known control point

© Read station setup data from instrument

© Use last setup

Measure at least two or three control points using the Add button.

Under Settings you can modify the station set up tolerances. By tapping Report you get more
information about the quality of your station establishment.

You can edit the total station components by checking and unchecking points or the horizontal
and vertical component.

If you do not know the name of the reference point being selected when carrying out either
station establishment process, simply move the target to the point that you want to measure,
or point the total station at an already established target. The target indicator moves in the
map to that location, making it easy to identify and select the correct point from the map view.

When selecting the third or subsequent point in either station establishment process, an Aim
button appears in the display. To turn the total station to the selected point location, tap Aim.
The total station turns directly to the selected point.

Tap Accept if the total station set up is within tolerance.
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Reading station setup data from the total station

After you have performed a station establishment, the total station stores the information in its
memory, so that other controllers running the software can access it. Subsequent users can save
time by simply retrieving the station setup information from the total station’s memory without
resetting up at an arbitrary location or on a known control point.

Completing a station establishment where the height
of the setup point has not been determined

If the height of the total station has not been established at the end of the station establishment
process, the software prompts you to either enter a known height for the setup point or to a height
from a known benchmark location defined as a 1D or 3D point. This occurs when:

e setting up at an arbitrary location, the reference control points measured were all 2D points.

o setting up a known point, the known point and reference control points selected were all
defined as 2D points.

The benchmark point is measured in the same way as any other control point. It is used in
combination with the target height and instrument height to determine the setup point elevation.

Working with a mechanical total station

In addition to the Trimble SPS series of total stations, the software also supports Nikon® and
Trimble mechanical total stations. Most of the functions work exactly like when using a robotic total
station.

1. Set up the total station over a known point and then level it using the bubble and electronic
level of the instrument.

2. Enter atmospheric and other distance correction values using the instruments' on-board
software.

3. Select the method of the station establishment and proceed as described in this chapter.

Measuring with a mechanical total station

Measuring with a mechanical total station works exactly the same as using a robotic total station.
Walking and Vehicle Mode are not available with mechanical total stations.

Staking with a mechanical total station

Guidance to a stakeout point works similar to staking with a robotic total station. An additional
arrow on the top right of the Measurement screen indicates how many degrees you need to
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manually turn the total station until reaching the direction of the stakeout point.

« |LPCTEEZZE | Ha: 220 20° 33 | VA: 90° 00' 27"

4 | Come Near: 4.306, Go Left: 34.648
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After the person on the rod was brought in line with the total station, the total station button on
the bottom right will take a measurement. The distance to the point which should be staked is
indicated in the Info bars. Make sure you have GO, horizontal, and vertical angle turned on in the
info bar.

Once the rod is within the stakeout tolerance, tap the button with the stakeout flag to stake the
point and receive the stakeout report. The software creates a Stake Marker report. A graphical
diagram shows how to put an elevation mark on the stake. The way the software calculates the
elevation mark and cut/fill depends on the Stakeout Settings in the Trimble icon menu.
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CHAPTER I I

Machine Control

In this chapter:

m Setting up for machine control
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Setting up for machine control

From the Home menu, tap Total Station / Machine Control Setup:

Her

e

Machine
Control Setup

If the instrument has the OEM option installed, an OEM Mode is available. To set up the instrument
for a Trimble GCS900 machine control system, select Machine Control Mode.

Define Search Window

Instrument mode: |Machine Control Mode j
Aim at a corner of the searchowindow and nrees "Sat!
m Machine Control Mode
OEM Mode

Q = Q

Defining the window for Full Search mode

Define the window for the Full Search mode:

e Accommodate the fact that the prism can be mounted on an electric mast, and that the
window of operation at close range will be higher or lower than at longer ranges.

e Ensurethat you set the window of operation to cover the extents of all grading operations to
be completed from that location (instrument setup).

e Ensure that if the machine is taken outside that window, to turn around or to bench on a
known height point, those locations are also included in the search window.

You can define either the upper left/lower right extents of your search window or the upper
right/lower left extents of your search window. Ensure that you take a good look at any high or low
points in the area where you will be working and then define your search window to what most
closely resembles the actual working area in front of you.

e Point the total station to an upper left location and then to a lower right location; tap the
appropriate Set button at each pointing.

e Point the total station to an upper right location and then to a lower left location, tapping the
appropriate Set button at each pointing.

As soon as the first corner is defined, the only option available in the software is to define the
opposite corner. For example, if you define the upper right extent first, the lower left corner only is
made available to define. If the lower right corner is set first, then the upper left corner only is made
available to define.
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Define Search Window

Instrument mode: Machine Control Mode ﬂ
Aim at a corner of the search window and press "Set".

Cancel

Assingle SPSx30 total station can be shared by multiple machines and a single SPS robotic rover pole
at, for example, at a bridge structure. Only one user can use the total station at a time, but when
not in use, it continually scans a predefined list of radio channels assigned to different machines and
the last used site positioning system channel in sequence, looking to see if anyone needs access to
the total station. When a machine or site positioning system calls the total station, it connects and
provides a positioning service. When completed, the total station returns to Standby mode and
becomes available to the radio channels previously loaded to the instrument. To facilitate this
process, in the set up for machine control process, you can create a list of machines, each with a
name and a specified radio channel, for example:

o CAT 140H Grader 133
e CAT D6 Dozer134

The machine list is scanned sequentially whenever the total station is placed in Standby mode for
machine control. The more entries in the list, the longer the scan takes to complete a full cycle and
therefore the slower the initial connection will be with the total station. If you are not continually
using the entries in the list in earthmoving operations, delete the entries from the list to speed up
initial connection times.

Tap Add to create a machine in the machine list, enter a machine name and assign a network
channel. Also, select a Network ID for the instrument.
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Edit Machine List
Network ID: |3 ﬂ

Channel\ Machine Name |
31 CAT 140H Grader

35 Liebherr PR724

38 Volvo Grader

Cancel

This completes the instrument setup. The total station goes into Standby mode waiting for a
machine to connect to it. Tap Finish to confirm the machine control setup:

Machine Control Setup

The setup is complete. Tap "Finish" to set the instrument
to the Machine Control mode.

Cancel " Finish

If you are tracking a machine and the target becomes lost for any reason, the total station continues
to turn at a constant horizontal and vertical speed for a short period, in the expectation that the
target will appear on the same trajectory when it clears the obstruction. A line-of-sight obstruction,
a passing vehicle, or simply losing the target because of movement speed can cause the total
station to lose the target. When the target is 'lost’, that is, the above method failed to reacquire the
target, the total station searches for the target. The total station has two search modes:

Mode Description

Quick Search Initiated as soon as the target is 'lost'. This search is centered on the last
known location, and inside a window defined by a horizontal angle width (for
example, 15°) and a vertical angle width (for example, 15°). The machine
control software sets the values for the search window.

Full Search This search looks inside a larger window, defined by the dialog shown
previously. When the Quick Search mode fails to locate the target, the Full
Search mode is initiated.
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If you are operating at the total station, point it at the MT900 target on the machine. When the
machine connects to the total station, this speeds up the initial search and lock-on process for the
total station as it instantly “sees” the target and locks to it. The total station goes into Standby
mode for machine control and then it scans the machine list in chronological order until a machine is
found calling the instrument on one of the channels. The software now disconnects from the total
station. Move to the machine and initiate connection to the total station.
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CHAPTER

Advanced Total Station Features

In this chapter: Direct reflex (DR) technology is included in all

= Scanning stockpiles SPSx30 Universal Total Stations as well as all
SPSx20 Construction Total Stations. This
technology offers many advantages such as
stockpile scanning for accurate volume
calculations.

» Adjusting the total station

The range varies depending on the total station
you are using:

= The SPS620 and SPS720 total stations offer
DR Standard technology, which enables you
to measure reflectorless, to a maximum
distance of 150 m (492 feet).

= SPSx30 total stations offer DR+ technology,
allowing reflectorless measurement of
objects up to 1,600 meters (5,249 feet) from
the instrument.
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Scanning stockpiles

The Stockpile scan is designed to collect very accurate data for reporting on the volume of material
that you have or that you have excavated. By scanning the stockpile or excavation, the need to
place a worker in potentially unsafe conditions is eliminated. Reflectorless measurement technology
enables you to set up the total station and measure to surfaces without using a target or prism.

Given the line-of-sight restrictions when using a total station, you need to perform a minimum of
two station setups to collect all sides of the stockpile:

1. From your first setup, measure new control points around the stockpile in locations that will
give you the fewest setups and the best vantage points to scan the largest surface area of the
stockpile. This enables you to collect all sides of the stockpile and have the surface points
correctly related to each other.

2. Once the whole stockpile has been scanned, define a volume boundary in the Volume & Cogo
menu by tapping the points to be used to define the boundary, and then perform a volume
calculation in the field.

To set up stockpile scanning:

1. From the Home menu, tap Total Station and then tap Stockpile Scanning.

2. The software sets the instrument to DR mode, and then the following screen appears:

Stockpile Scanning Setup

Tap the buttons in the diagram below to define the scan area.

Cancel

3. Define the shape of your stockpile. Start by tapping the gray dot at the highest point of the
stockpile image on the screen.

4. Manually sight your instrument to the highest point of the stockpile and then tap Measure.
The Point Mode dialog appears.

5. Ifrequired, enter a point code and point name and then tap OK. The Stockpile Scanning Setup
dialog reappears.

6. Repeat Step 4 through Step 6 to define the bottom left, bottom right, and bottom most points
of your stockpile. Once successfully measured, the points appear green:
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Stockpile Scanning Setup

Tap the buttons in the diagram below to define the scan area.

Cancel

7. Tap Next. The Stockpile Scanning Settings dialog appears:

Stockpile Scanning Settings

Point name: |Top036

Point code: |
Horizontal interval: 0.328 usft

Vertical interval: 0.328 usft

Minimum distance: 13.281 usft =%
Maximum distance: |1968.500 usft =%
Timeout (seconds): 1

Cancel

8. Enter a point name and code and set the distance intervals. Setting the distance intervals low
results in more measured points; setting the distance intervals high results in fewer measured
points. When entering these values, keep the size and shape of the stockpile in mind. Define
your minimum and maximum distances and then tap Next. Correct use of these settings helps
you collect only relevant points in the field. The software will default to the recommended
Timeout value depending on which instrument is being used.

9. The Scanning Area Estimates dialog displays the total number of points to be collected as a
result of the dimension and distance intervals previously entered and an estimation of the time
it will take to record the points. This time is an estimate only and the reflectivity of the material,
distances involved, and the type of instrument used alters the total time once the scan has
started.

Trimble SCS900 Site Controller Software User Guide 90



12 Advanced Total Station Features

10.

11.

12.

Scanning Area Estimates
Rectangle Dimensions

Width: 293.232 usft

Height: 3.608 usft
Scanning Points

Horizontal: 894

Vertical: 11

Total Number: 9834

Estimated Time: 2 hr 44 min

Cancel Start

& CAUTION — The values stored in Step 8 are overwritten by the minimum and maximum values set in the DR
Target Settings dialog. Ensure that you check the values set in the DR Target Settings dialog to eliminate
confusion by another operator when they are setting the Stockpile Scan settings. Setting the minimum
distance to 2 meters (6.56 feet) and maximum distance to 1600 meters (5,249 feet) in the DR Target
Settings dialog will eliminate any errors when setting the Stockpile Scan settings.

Tip — When working at the maximum ranges of the DR technology, increase the Timeout Setting. When adjusting
the timeout settings, be aware the material being measured affects the strength of the response signal. Also, the
instrument's technology affects the time it takes to record each individual point.

Either tap Esc to go back and change any settings before starting the scan or tap Start to start
the scan.

Agrid is displayed as the scan proceeds. Scan time remaining is displayed in the Estimated Time
Remaining field. If you need to change the minimum and maximum distance settings, tap

0

Pause and then tap
The scan will resume.

. Change the minimum and maximum settings and then tap Next.

Tap in the map control bar on the left to display the map view so you can see the points
being collected.

?

Tip — For an explanation of the different grid sector colors, tap in the upper right of the screen. The
following screen appears:
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Scanning Help

- Point scanned successfully

I Point being scanned

I Point selected to be rescanned
|| Point to be measured

-] Point out of the defined area
[ ] Unable to measure distance

[l Not Measured

13. Torescan any cells, tap OK to return to the measured cells display. Tap the associated grid
sectors with your stylus. Selected sectors turn blue. Once the selection is made, tap Rescan.
Repeat the rescan function until results are satisfactory and then tap Finish.

Adjusting the total station

All total stations require regular and routine checks and adjustments to deliver optimum results. All
Trimble total stations allow fully accurate measurements to be made with a single pointing to a
target. To achieve that, the total station stores its current adjustment values internally, and then
corrects all measured data accordingly. For accurate measurements to be made, the current
adjustment values need to be determined and stored in memory. Total station adjustments are
required because of the optical mechanical design of the instrument. The following conditions can
move the optics and mechanics out of adjustment:

¢ Shipping and handling

Bumps and knocks

Temperature and pressure changes

Storage conditions

General wear and tear of mechanics
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To start the calibration:

1. From the Home menu, select Total Station / Total Station Calibration.

Compensator Calibration

& CAUTION — You must perform this calibration before the HA VA Collimation and Tracker Collimation. The
compensator does not need to be calibrated every time the other collimations are performed, but if the
Compensator Calibration is performed, you should immediately perform the HA VA Collimation and Tracker
Collimation. Performing the Compensator Calibration negates the validity of the values of the errors found
from previous HA VA Collimations and Tracker Collimations.

The SPS family of motorized total stations is all equipped with a dual-axis compensator. The
compensator is active when the total station is switched on. You should periodically calibrate
the compensator to adjust for any minor changes in the total station caused by normal wear
and tear, as well as shipping or temperature variations. It is extremely important to perform
this calibration when you are working within a very tight tolerance range. You should also
perform this calibration whenever the highest accuracies are needed.

2. Tap Start to initiate the instrument Level Compensator Calibration:

Total Station Calibration

Please make sure the instrument's handle is attached.
Press "Start" to start the instrument Level Compensator
Calibration.

Info
Compensator calibration complete.

3. Tap OK.

HA VA Collimation test

You should perform this test to a target that can be easily bisected with both the horizontal
and vertical cross-hair, placed at a location at least 100 m (328 feet) from the total station, and
at approximately the same elevation as the total station telescope. The target can be any
object including a road sign, window frame, or an adhesive prism target. The test involves
taking a series of HA VA measurements to the target in both instrument faces, to generate a
mean or averaged pointing in face 1 and face 2, from which the difference between face 1 and
face 2 readings can be determined. The difference between the two face readings is known as
the collimation error. In the horizontal axis, the collimation error has little effect on
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measurements. However in the vertical axis, if not corrected for, the collimation error will result
in erroneous elevation values for all measured points.

4. Enter the number of measurements, aim at the target and then tap Measure:

Total Station Calibration

Set target at about 100m away and aim at the target for
HA VA Collimation.

Number of measurements: 3 E,

Press "Measure" to take measurements.
Face 1 observations: 0

Face 2 observations:

| Measure

The collimation test computes the collimation error, stores the error inside the total station
and then corrects all subsequent measurements for that error before displaying them on the
screen or storing them in memory.

5. Tap Next.

Tracker Collimation test

You should perform this test towards a prism or active target set up at a distance of around 100
m and at approximately the same elevation as the total station telescope. Ideally, perform the
test at the approximate range that subsequent measurements will be made.

The test involves the total station locking onto and measuring an average position over a
period of time in both faces to determine any misalignment of the tracker in relationship to the
telescope cross-hair. If not corrected for, this error results in erroneous position determination
in both horizontal and vertical axes, and also between measurements made with and without
Autolock technology. Once measured, the error is stored in the total station, and is used to
correct all subsequently measured positions.

6. Aim at the target and tap Measure:
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Total Station Calibration

Aim at the target and press "Measure" to start tracker
collimation.

|[ Measure

Note — There can be two reasons for significant change between old and new values: The total
station has received a knock or bump in transit that may need a service correction. There has
been an observation error.

If you suspect an observation error, repeat the process. If the values are repeated, you may
want to contact an authorized Trimble Service Center for advice. When the values exceed a
certain level, you will be advised to send the total station to an approved Trimble Service
Center for recalibration.

Note — The values displayed when new will be close to zero, but over time these are expected
to change. Non-zero values are no cause for concern; however, sudden large changes should
be cause for concern because they indicate misuse, abuse, or transportation problems. For
full details of the instrumentation errors, refer to your instrument manual.

7. Tap Finish.
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Glossary

benching Benching is a process of aligning your GPS position (latitude, longitude, and height) to
a benchmark that has been added as a reference point. The calibration offsets your
GPS position to that of the benchmark, improving accuracy and providing a point that
you can return to later.

AutoBase AutoBase technology uses the position of the receiver to automatically select the
correct base station; allowing for one button press operation of a base station. It
shortens setup time associated with repeated daily base station setups at the same
location on jobsites.

base station Also called reference station. In construction, a base station is a receiver placed at a
known point on a jobsite that tracks the same satellites as an RTK rover, and provides
a real-time differential correction message stream through radio to the rover, to
obtain centimeter level positions on a continuous real-time basis. A base station can
also be a part of a virtual reference station network, or a location at which GNSS
observations are collected over a period of time, for subsequent postprocessing to
obtain the most accurate position for the location.

DGPS See real-time differential GPS.

design map The map that provides live linework within a design for stakeout operations. The
design map is a DXF file.

differential Differential correction is the process of correcting GNSS data collected on a rover

correction with data collected simultaneously at a base station. Because the base station is on a
known location, any errors in data collected at the base station can be measured, and
the necessary corrections applied to the rover data.

Differential correction can be done in real-time, or after the data is collected by
postprocessing.

differential GPS See real-time differential GPS.

elevation (elev, (1) Vertical distance (height) above or below mean sea level. (2) Vertical distance
elv) above or below the geoid. (3) Distance above or below Local Datum.

elevation mask The angle below which the receiver will not track satellites. Normally set to 10

degrees to avoid interference problems caused by buildings and trees, atmospheric
issues, and multipath errors.

feature A feature is a physical object or event that has a location in the real world, which you
want to collect position and/or descriptive information (attributes) about. Features
can be classified as surface or non-surface features, and again as points,
lines/breaklines, or boundaries/areas.

GLONASS Global Orbiting Navigation Satellite System. GLONASS is a Soviet space-based
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navigation system comparable to the American GPS system. The operational system
consists of 21 operational and 3 non-operational satellites in 3 orbit planes.

GNSS Global Navigation Satellite System.

GPS Global Positioning System. GPS is a space-based satellite navigation system consisting
of multiple satellites in six orbit planes.

height It can mean a target height or antenna height ( for example, 2 m of rod height).

Here position An autonomous instantaneous position derived from the GPS receiver’s uncorrected
latitude, longitude, and height.

IBSS Internet Base Station Service. This Trimble service makes the setup of an Internet-
capable receiver as simple as possible. The base station can be connected to the
Internet (cable or wirelessly). To access the distribution server, the user enter a
password into the receiver. To use the server, the user must have a Trimble
Connected Community site license.

Location GPS Location GPS covers decimeter to submeter GPS positioning techniques including
Satellite Based Augmentation Systems (SBAS) such as WAAS, EGNOS, and MSAS),
DGPS (reference station and rover operations), OmniSTAR VBS/HP/XP services, and
Location RTK (decimeter-level RTK positioning).

Location RTK Some applications such as vehicular-mounted site supervisor systems do not require
Precision RTK accuracy. Location RTK is a mode in which, once initialized, the
receiver will operate either in 10 cm horizontal and 10 cm vertical accuracy, or in 10
cm horizontal and 2 cm vertical accuracy.

Precision GPS GPS positioning provided by techniques that typically deliver centimeter-level
accuracy. These include RTK (Real-Time Kinematic) techniques and signals obtained
from a VRS (Virtual Reference Station) system.

postprocessing Postprocessing is the processing of satellite data after it is collected, in order to
eliminate error. This involves using computer software to compare data from the
rover with data collected at the base station.

real-time Also known as real-time differential correction or DGPS. Real-time differential GPS is

differential GPS the process of correcting GPS data as you collect it. Corrections are calculated at a
base station and then sent to the receiver through a radio link. As the rover receives
the position it applies the corrections to give you a very accurate position in the field.

Most real-time differential correction methods apply corrections to code phase
positions.

While DGPS is a generic term, its common interpretation is that it entails the use of
single-frequency code phase data sent from a GNSS base station to a rover GNSS
receiver to provide sub-meter position accuracy. The rover receiver can be at a long
range (greater than 100 kms (62 miles)) from the base station.
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Road job A road job is the term that defines a complete road model within the Terramodel
and SCS700 software. It is a collection of roadway information that is expected to
function together to define a roadway or a portion of a roadway between specific
stationing limits. A road job contains the main alignment and all sub alignments, the
road templates, and all the information used to define widening and super elevation
for the road. A single project can contain multiple road jobs for different roads also
contained within that single construction project.

road model The road model used by the SCS700 software is a Trimble Terramodel PRO file. This
file can be used for both staking and grade checking operations. The Road model is a
template based model that provides full accuracy anywhere within the roadway
surface.

rover receiver A rover is any mobile GNSS receiver that is used to collect or update data in the field,
typically at an unknown location.

Roving mode Roving mode applies to the use of a rover receiver to collect data, stakeout, or
control earthmoving machinery in real time using RTK techniques.

RTK real-time kinematic. A real-time differential GPS method that uses carrier phase
measurements for greater accuracy.

site A project that is to be worked on for a significant period of time. A site stores all
design data and all executed work orders so you can easily find data whether you are
in the office or in the field.

site map The site map within the SCS900 software is stored as a part of the site data. The site
map provides linework as a reference only and is not live, which is why you cannot
select it for stakeout purposes.

station A station is the running distance along the centerline or road that starts at 0.0 and
increments as you proceed along the route. This term is used primarily in the US,
whereas the equivalent term chainage is used throughout many other areas of the
world, such as Australia, Asia, Europe, and New Zealand.

surface model The surface model used by the SCS700 software is a Trimble Terrain Model file (TTM
file). It provides a 3D surface model that can be used for stakeout or grade checking
operations.

work order A work order covers a task to be performed by a crew on a single jobsite. A work

order contains the reference to the appropriate design, required settings and
tolerances for the task, and a record and report of all the data measured or staked
out in the process of completing the task.

A work order can cover a short-term task (such as the stakeout of a specific building
pad) or a task that will last the duration of the project (such as the stakeout of storm
water drainage) and that will be executed periodically as required during the project.

When the project is complete, all the information regarding the task is stored in a
single file that is easy to recall.

Trimble SCS900 Site Controller Software User Guide 98



	USER GUIDE

	
Safety Information
	Use and care
	Vehicle safety
	Servicing
	Accessories

	1   
Introduction
	Related information
	Technical support

	2   
Starting the Software
	System information

	3   
Menus
	The Home menu
	The Site menu
	The GPS menu
	The Total Station menu
	The Import/Export menu
	The Measure menu
	The Stake menu
	The COGO menu
	The Exit menu

	4   
Measurement screen
	Measure modes
	GPS measure mode
	Total Station measure mode

	Status bar
	GPS mode
	Total Station mode

	Precision GNSS control icons
	GPS mode

	Map options
	Map control
	Measure tab
	Design tab
	Layers tab
	Rotate tab

	Toggling between Plan and Cross Section view
	Info bars
	Antenna Height / Target Height
	Trimble icon menu
	Measure menu
	Stakeout menu


	5   
Data Management
	Sites, Designs, and Work Orders
	Creating and opening a work order in the field
	Connected Community service
	Registering the controller
	Wireless Data Sync
	Remote Assistant


	6   
Measurement Workflows
	Displaying cut/fill
	Checking a grade/elevation
	Checking material thickness
	Measuring a surface or a feature
	Measuring with feature codes – Advanced Measurement module required
	Photos


	7   
Volume and COGO
	Compute Volumes
	Review & Edit Data
	Create Points/Arcs
	Enter/Edit Stakeout Points

	8   
Stakeout Workflow
	Points
	Stakeout Settings
	Measured Point
	Ground Surface
	Top of stake

	Lines
	Slope staking
	Reference Line
	Surfaces
	Roads
	Roadway feature staking
	Simple feature offset
	Custom feature staking
	Custom segment staking
	Catch point staking
	Location on Surface


	9   
Measuring with GPS
	Setting up the GPS base station
	Setting up the GPS rover receiver
	Calibrating the site
	Performing a two-point calibration
	Troubleshooting a site calibration

	Measuring a new control point

	10
   Measuring with a Total Station
	Connecting to a total station
	Leveling the total station
	Establishing the station
	Arbitrary location
	Setting up on a known point
	Reading station setup data from the total station
	Completing a station establishment where the height of the setup point has no...
	Working with a mechanical total station
	Measuring with a mechanical total station
	Staking with a mechanical total station


	11   
Machine Control
	Setting up for machine control
	Defining the window for Full Search mode


	12   
Advanced Total Station Features
	Scanning stockpiles
	Adjusting the total station

	
Glossary

